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INTRODUCTION

The Provincial Plan for the Province of Bavao del Sur
1.3.2 Outline of the Report

Tabhle 13,1
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s I GENERAL i
¥, |1he Phulippine Natiopal Development Plan
Program Master Planning 1098 NEDA
2. |Reportand Recommendation of the Preswdent to
the Board of Directors an Propased Laans to the
Republic of the Philippines for the Rural Water
Supply and Sanitation Sector Project May 1996 ADD
3. [Report and Recommendation of the Presideat to
the Board of Directors on a Proposed Loan to the
Republic of the Phitippines for the Regional
Municipal Developmcat Project Aug. 1935 ADD
4. |Long Tenn and Medium Teom Scctor Dev't.
Planning Workshop No. 3 1995 DG
5. [Philippine Agenda - A Natioral Agenda for
Sustainable Development for the 2st Century 1997 PCSD
& |Updatad Modivm-Term
Pinlippine Development Plan 1906 - 1998 Dec. 1995 NEDA
7. {Water Supply, Sewerage and Sanitation
Master Plan of the Philippincs 1988 - 2000 1938 NEDA
8 JCatalogue Producis and Services 1993 NAMREA
9. |The Philippines tn 1995 Our Time Has Come June 1995 op
10. fAusiralian Development Corporation with the
Philippines - Philippine Program Profile
{ScctionCLY) July 1997 LGU
11. |Social Refonn Agenda Poticy Directives Social Reform
Counct] Secretanat
12. [Comprehensive Pev't. Plan [or the Province of
Davao det Sur - 1997.2001 1996 PPDO
13. |The Study on the Davao Integrated Dev't.
Program Master Planning Dec 1997 DIDP
. - SOCIQ-ECONOMIC
3. [Socio-Economic Profile {Davao del Sue) PPDO
2. |Data Eacoding and Processing and Population
Frojection Workshop No. 2 1994 - 1995 LG
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3 [Census-Dased Natioral and Regiona! Population
Projection Voleme § 1995 NSO u
4. |Report No. 1-P: Population by Province, City/
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Southesn Mindanao 1995 Census 1995 NSO =
5. Report No. 2-36F: Socio Fconomic and
Bemographic Charactoristics
Pavao del Sur 1995 Census 1995 NSO u
6. |Philippine Statistical Yearbook 1997 NSCB =
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Age Bracket 1935 NSO POPCEN Ll
§. |Geographic Coding and Urban and Rural
Classibication (Regimn X1} 199¢ NSO POPCEN "
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Number of Hovscholds by Provinee, City
Municipality and Barangay 1693 NSO Census u
1, . WAYERSOURCE
1. |Master Plan Stdy on Water Resources
Management in Repubtic of the Philippines Vol. ] Jan. 1998 NWRDB L
2. [Master Plan Stady on Water Resources
Management in Republic of the Philippines Vol It fan. 1998 NWREB 2
3. |Phihppice Water Resousces Data Volume (I g
Streamflow and Lake or River Stage Jan_ 1980 NWRC a
4. |Philippine Watcr Resources Data Volumiz |1
Streamilow and Lake or River Stage June 199 NPWH-BRS n
5. Master Plan Study on Water Resources
Maragement in the Republic of the Philippines hety 1997 NWRDB =
6. |Tepogezphic Maps 1:250,000 Reprinted in
Davao del Sur 91,93 and 96 NAMRIA
Rapid Asscssment of Water Supply Sources 1982 NWRD
Davao def Sur
Groundwater Resources Investigation Repont Unpublished NWRB
Davao del Sur
Water Resources Sununary Data
{(Volume 1 and 2) 1970 Southern
Tadividual Well Inventory 1990 NWRB
Davao del Sur '
Groundwater of the Philippines Hune 1980 NWRC




§

B Title - Year
120 |LAWUA Water District Database 1997 LWUA
13, [Rooad Network Map
Davao del Sur
4. |Well fnventory NWRB
15, |Weli Inveniary 1998 DPWNH-DEO
16. |Wel) Drilling Record 1598 DPWH-DED
v T WATERSUPPLY.
I {Assessment of the Pomestic WS and Sanitation
Scetor of Seuthern Mindanao Volume [f Aug. 1996 NEDA
2. fAssessment of the Domestic Water Supply and
Sanitation Sector of Southem Mindanao Vol. IH Aug. 1996 NEDA
3. |Technical Assistance to the Republic of the
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4. {Working Group on Urbanization (WG/U) of the
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5. Water Suppy Feasibility Study Methodology
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12, |Nine Package W3 Feasibility Study T'roject
Package T B¥igos Water District 1998 LWUA
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Package 1 Hagonoy Water District 1998 LWUA
t4. |Report and Recommendation of the President to
Board of Direciors on a Proposed Loan to the
LWWA in the Republic of the Philippines for the
Small Towns Water Supply Sevtor Project Sept. 1996 ADD
15. |Matalag Bay Alliance Wide Water Supply,
Pre-feasibility Study, Technical /Financial
Analysis Review {or Key Municipalities 1998 MBA-PAIC
V. | . ENVIRONMENTAL SANITATION
1. {Trainer's Training Kits for Sanitation Mar. 1996 UNDPOILG
2. |Ecological Alernatives in Sanitation Aug. 1997 SIDA
3. |The Code Saniation of the Philippines 1976 DOH
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4. |Pre-feasibility Report for Saniation and
Sewerage, Davao, Philippines 1993 World Bank »
vi. | T INSTITUTIONAL T
1. [Gereral Primer - Local Government Code of 1991 1591 DILG n
2. |¥he Barangay and the Local Governmen Code 1994 DIG n
3. INEDA Doard Resolution No. 4 (8. 1994) 1994 NEDA L
4. Hmplementing Rules and Regelations of
NEDA Boznd Resolution No. 4 (S, 1994},
Clause (G} Nov, 1997 NEDA L
5. INEPA Board Resolution No. 5, 8.94 1594 NEDA n
6. [NEDA Board Resolution No. 5, 5-96 1596 NEDA L
7. [NUDA Board Resolution No. 5, 5-89 1989 NEDA -
ViL | COMMUNITY DEVELOPMENT
. [Community Developmeoni Manual DPWIVDILG! "
First Water Supply, Sewerage and Sanitation LWUADONI
Sectors Projocts (FW4SP)
2. {BWSA Formulation Operations Manual DPWH/DILG! u
Comnunity Development Manual LWUAMOH
First Water Supply, Sewerage and Sanitatien
Sectors Projects (FIW45P) g
3. Hnstition Building for Decelralized Inplementation
of Community-Managed Water Supply and
Sanpation Projects DILG L
4. [institution Boilding for Decentralized Implement-
ation of Cornmunity-Managed Water Supply
and Sanitation Projects June 1997 OILG L
5. [Guidebook for Conmunity Managed WATSAN
Project UNDP/PHI L]
6. 1A Manual for Training Trainors in Participatory PROWWLSS/ L
Techmiques 1900 UNDP
7. |intecccption Report for Special Assistance for
Projects Sustainability for the Rural Water Supply
IIE Project 1937 SAPS Team =
8 [{tnterim Report for Special Assistance for Projects
Sustainability for the Rural Water Supply HE
Project (SAPS) 1997 SAPS Team u
9. [Panticipatory Action Pianning for the Developmeat
of Two PSF Project 1994 up
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10. |Waler and Sanitatian for Al A World Prionity 1995 {RC International -
Achicveraents and Challenges Water & Social Center
12, [Community Organizess' Manual, Pane | 1990 CSWCD-UPBCD/
DOPI
13. |A Handbook on Community Development 1975 up u
14, {Achieving Succass in Community Water Supply UNDE u
and Sanitation Projects
15. [Handbook on Community Organizing for Water DILG n
Sanitation
16. |Draft Final Report for Special Assistance for
Projexts Sustainability for the Rural Water Supply
[11 Pegject Feb. 1997 SAPS Team ]
17. A Manual on Community Participation in Water =
Supply and Sanitation {RIWVSSP)
18, |Achicving Success in Community Water Supply amd
Sanmitation Projects 1980 WIHO -
i9. |Community Development Manual Nov. 1995 PIC u
VILL] - - GENDER -
1. |Sourcebook for Gender Issucs at the Policies Level
in the Water and Sanitation Sector Qe 1996 IBRDAVD -
% 2. |Gender Issues Sourcebook for Water and Sanna-
tion Projects Jan. 1995 IBRDAVE n
3. |Toolkiton Gendorin Water and Sanitation
Series No. 2 Aug. 1996 UNDP L
4. |Domestic Shallow Well Water Supplics the Family
Handpump Scenario Feb. 1990 UNDP n
5. [United Nations Decade for Wonien 1976-1985 L
6. {Gender Mainstreaming NCRFW L
7. [Regional Memarandums Feb. 1997 DILG .
8. {Phitippine Plaa for Gendor Development 1995-2025 NCREW =
9. |Phitippine Couniry Report on Women Sept. 1995 NCREW =
10. [A Primer on the GAD Focal Point 1596 NCRIFW u
x L FINANCIAL
1. JAsnual Investment Plans
Davay del Sur (g 0] n




L Year | Source G ¢ RIFIM g_i_]

2. |Family Income and Expenditares Survey Vol. | 1994 NSC »
3. |Fanuly Income and Expenditures Survey Vol T 1994 NSO L
4. LG Memorandum Circular $6-263 1996 MG »n
5. [Presidential Decree 1914 (MDF) 1984 op -
6. Point Cizcolar No. 6-87 Aug. 1087 DBM s
7. |Davao del Sur Accomplishment Reports,

1993-1996 1993-1936 PPDO n
10 Statement of Incomea-

Expenditurcs of Municipalities FPFDO u
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ADB - Asian Development Bank

BRC - Burcau of Research and Standards

BRS - Barean of Regional Standaed

CSWCD - College of Socio Work and Community Developrment
BCD - Departiuent of Commnity Bevelopoient

DEQ - Disuict Engineer Office

DILG - Deparbnent of Interisr and Local Goverumcat

D023 - Deparonent of Health

DOPI - Developucnt Options Philippines, Inc.

DPWH - Deparientof Works and Highways

18RI+ Intemational Bank for Reconstruction and Dey tlopraent
LGU - Local Govenimert Unit

EWUIA - Local Water Ultitities Administration

MODF - Municipal Development Fund

NAMREA - National Mapping & Resource Information Authority
NCRFW - National Comemission in the Role of Fitipino Women
NEDA - National Ecenenic Developmetst Authority

NSCH - Rational Statistic #l Coordination Board

NSO - Nationa!? Statistics Office

NWRE - National Water Resource Bureas

NWRC - National Water Resowrce Council

OF - Oftice of the President

PCSD - Fhilippine Counse) for Sustainable Developasent

PH1 - Fhilippine tsland
FIC - Profect implementation Consaliants
FOFCEN - Population Census
PPDO - Provineial Planning and Bevelopinent Office
PROWWESS - Promnotion of the Role of Women in Water,
Emvironmentzs and Sanitation Sources
ROC - Regional Development Council
SIDA - Swedish Inseruaiional Development Cooperation Agency
LN « United Nations )
UNDP - United Nations Development Projece
UP - Univessity of the Fhitippines
WATSAN - Water and Sanitation
WB-Wold Bank
WHO » World Health Organization
WECC-WGU - Water Supply & Sanitation Collaborative
Council-Working Group on Urbanization
G - Globak
C - Central Goverment Level ¢ ;
R - Regicnal Govermimcnt Leved ¥ A
P Provingial Level
M. Municipal Level
B - Parangay [ evel
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42,2 Types of Facilities and - DOH/D_ECS cliséii':bation by service level F4.2.1 Standard Seructure of
Definition of Service Level - Types of wiler facilities considered as sani- Private Toilet Facility g
Standard tary and unsanitary in this sector plan o {
- Definition of served and underserved/ F4.2.2  Standard Structure of |
unserved - School Toilet Facility A
4,2.3  Sanitation Faeilities and
Service Coverage
(1} Household Toilets - MNo. of Houscholds with sanitary toiet T4.2.1  Sanitation Facilities and T4.2.1 Saniation Facilities and
facilities and underserved, by municipality Service Coverage of Service Coverage of House-
Heusehol Toilets, Urban hold Toilets, by Type, by
- Service coverage (perceant of household and Rural Municipality, Urban and
with sanitary toile facilities and under- - Rural, 1997
served/unserved in urban and rural ares, F4.2.1  Provincial Service Coverage
by municipality of Houschold Toilet Facilities | T4.2.2 Number of Student and
L School Toilet Facilities by
- Problems and countermeasures Municipality i
i
(2) School and Public . No. of Schoal and public toilets by T4.2.2  School Toilet Faciliticsand  |T4.2.3 Number of Public Toilets
Toilets municipality : . Service Coverage Facilities
- Service covarage (percent of students
T4.23  Public Toilet Facilities and

* Questicuraire form
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4.2.4

5.1

5.2

5.3

5.4

Table of Contents

(3) On-going Projects

Sewerage Facilities

EXISTING SECTOR
ARRANGEMENTS AND
INSTITUTIONAL
CAPACITY

General

Sector Reforms

Sector Instiwtions

Sector Agencies at the
Natignal Level

(1) DILG
(2) LWUA

(3) DPWH

angeng

- Problems encounterad with regards to
physicals and social standpoints and
countermeasures. -

- Dﬁ_-going projects by rmunicipality .
(service coverage)

- Presence/absence of sewerage facilities. If
none, description of existing condition on
sewage disposal '

« If present, description of sewerage system

- NEDA Board Resolution No. 4
- NEDA Board Resolution No. 5

- Existing Institational Amangements
- Sector Financing (cost sharing arrangement and
{inancing and management systers)

{To be discussed for cach of the major
agencics)

- Existing mechanisms and processes 1o
deliver or support services to provinces,
mupicipalities and barangays (financial,
technical and institutional)

- Mechanisms for coordination and collabora-
tion with LGUs. -

F5.3.1
T5.3.1

Functional Relationships
Transition Functions of the
DPWH, DILG and DOH

* Questionnaire form

RN
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5.5

{4y DOH

(5) Other Agencies
(NEDA, DOF, NWRE,
DBM, DENR. DECS,
NWRB) .

Sector Agencics at the
Local Level

(1) Provincial Level
< PPDO
- PEQ
- PHO
- Others

(2} Municipal and Barangay

Levels

- MDO

- MEQ

- Barangay Councils
- RHU/BHS

(3) Field Offices of Central
Secior Agencies
- DPWI DEO
- DILG PMLGOO
- NEDA RO and RDC

(4) Water Dismicts .
(5) RWSAsBWSAs
{6) Others (in¢luding CBOs)

- Existing capacity of national agency ©
implement sector projects (rechnical, .
financial, institetional) -

- Actual programs being :mplemcnted by

national scelor agencies focusing on transfer

of appropriate ‘technologies and approaches

Aciual experiences. and, practices of national

agency in project implementation

Problem areas : .

1

e

(Tobe discus:-ad for mh of the agcnc:c:-)

General description of mandate and

responsibility

Present capacity of local agency to under-

take: the LGU level within the sector

* Project identification and priority-seting

* Establishment of community-based
organization

* Project preparation and planning

* Project implementation
* Operation and maintenance .

* Monitoring and evaluation ..

Finaneial resources (Refer to Chap 6)

Actual cxpencnces and practices of local

agencies on project. xmplemcmanon

. Mechanism for coordination and collabora-
tion level among local offices to implement,
coordinate and monitoring of progmm
ACTivItics

- Extent of private sector pammpanon

- Linkage with national government agencies

v

Fs.5.1

F5.5.2

F5.5.3

Organization Chartof the
PPDO

Organization Chart of PEO

Organization Chart of
PHO

= Questonnaire form

Table- T, Figurc- F
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Capability of the Municipal
Government

Table of Contents Contents, Main Report Suppoarting Report Data Report
5.6 Extermal Suppott Agencies
Active in the Sector
(1) Multilateral Agencies - The World Bank (IBRD} T5.6.1 Priority Ar¢as/Terms and
- The Asian Development Bank (ADB) Conditions, Programs and
- The United Nations Development Program Projects by Donor
and the United Nations Children’s Fund
(UNICEF)
(2) Bilateral Agencics - The Japin Imemational Cooperation .
Agency (JICA) |
- The Overseas Economic Cooperation Fund i
(QECF)y . . -
. The Australian International Development ﬁ‘
Assistance Bureau (AIDAB) |
- The Canadian International Development [;
Agency (CIDA) L
(3) NGOs and Private | ?
Sector |
i
5.7 Project Management
Amangements and [ssues and :
Problems
5.7.1  Technical Aspect }
5.7.2  Institutional Aspect T5.7.1 Office/Agencies involved in !
WATSAN project i
5.7.3 Financial Aspect :
5,74 Institutional Arrangements and

* Questionoaire form

Table- T, Figure= F
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5.8 Community Development

$.8.1  General

5.8.2 Provineial CD Structure and
Linkages for WATSAN
Sector Projects

$.8.3  Assignment of CD Specialist
10 Seqtor Projects

Cantents

- Structure and Linkageo CD

- Existing CD approaches 1o premote partici-
pation of local bencficiaries

- Experiences/praclices on participation of
project beneficiaries

- Health and Hygiene Education

- Strategies for targeting involvement of
woren

- Training of LGUs and bencliciaries

- Result of surveysfinterview

- Staffing situation (quality and quantily}

- Existing training programs of sector agencics
and mechanisms for implementation
(technical and management training}

- Access to technical information

- Available training and information materials
* Types.and Gontents ;-

* Mode of disserination -

- Actual cxpcncnccs and practices of sector

agencies .

- Existing health/hygiene cducation programs
of sector agencies and mechanisms for
1mp!:mcntati6n S
=DOH (Implcmcnting'program on Public
Toilets) -

* DECS (Implemcnnng prog-ram on School
Toilets)

- Mechanisms and resources for mass dissermi-
nation of information and other sotial
marketing programs

* Questionpaire form

Table- T, Figure - F
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5.8.4

5.8.5

5.8.6

SRT

5.8.8

5.9

5.5.1

5.9.2

3.9.3

Training on CO
Utijization of NGOs

Existing Community
Developrent Processes

fnformation, Education and
Cormmunic¢ation As Foundation

Activities for Community
Development

Health and Hygi¢ne Education

Gender

General

The Evolution of Gender and
Development

The LGUs and Gender

- Hygiene educational materials available
* Types and content
* Mode of disscmination

- Actual experiences and practices of sector
agencics (national-and local-level)

« Manner of parti¢ipation in sector develop}ncnt
- Typical CD work )

- Existing IEC program on sector plans in
province, municipality and barangay and WD
- Importance of IEC programs

- Existing HHE programs and medium of
dissemination
- Importanee of HHE programs

- Gender Participation in WATSAN Projects
- Gender Training
- LGUs and Gender Awareness

Asisa

* Questionoaire form

Table- T, Figure = F
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Invesmment Plans

{profile of sector investment to allotted IRA in
the provinge) ) ‘

1995-1998 .

. Tables & Figures
Table of Contents Contents ¥Main Report Supporting Report Dara Report
i
553 The LGUs and Gender !
594 Gender in WATSAN Sector - Gender participation 1n sector development |
Projects projests |
« Gender in water supply and sanitation practices |
5.10  Existing Project and Sector - Scclor monitoring, primary sources of sector F5.10.1  UNDP/PHI2/010 Project
Monitoring. data . .. Participatory Monitoring
« Projeet monitoring system of related WATSAN Feedforward and Feedback
project Management Mechanism
16. PAST FINANCIAL
PERFORMANCE IN
WATER SUPPLY AND
SANITATION
6.1 General - Basic idea and brief discussion on contents of T6.2.1  Income and Expendilures, T6.2.1 Statement of Income and {
this chapter 1994-1998 Expendrtures, 194-1998
6.2 LGUs Past Financial T6.2.2  Past Internal Revenue Allot- [T6.2.2 Past Intermal Recenue
Performance ment to the Province Allotment to Municipalities
' _ from Central Government i
6.2.1  Sources and Uses of Funds - Discussion on LG&Js Major Sources of revenues |T6.2.3  Available Funds for Capital i
and its expenditures Expenditures, 1994-1998
6.2.2  Availablity of Funds - Ra is the target income source
T6.2.4  Other Sourees of Funds for
6.2.3  Financial Indicators Capital Expenditures and
20% DF, 1994-1998 i
[6.3 Past Public Investment and (1} Study on the previous public investment to T6.3.0  Previous Sector Investment
Present Plans the province by concerned agencies o the Province by Con- i
’ ) cemed Agency
#6.3.1 Past and Current Annyal (2) Discussion on the manners of using the 20% DF
T632  Arnual Investment Plan,

* Questionnaire form

“Table- T, Figure - F
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6.3.2  Past and Current Breakdown T6.3.3  Annual Activitics in the T6.3.3 Sector Allocation in the
of 20% DF Water Supply Sector Annual Investment Plan
6.3.3  Existing Plansos LGUs for the | - LGU's existing program for WATSAN Sector  1T6.34  Alloeation of the 20%
Sector : Development Fund,
1994-1998
64  LGU's Financing Sources - LGU's involvement in Financialy in
and Manzagement WATSAN
Participation in the Sector
64.1  Cost Sharing Arrangements/ - New cost sharing scheme T6.4.0  Financial Indictors of
Counterpart Funding Provincial / Municipal
Walerworks
6.4.2 ODA Assisted Projects an - Past Experience with Funding Organization T6.4.2  Loan Status of Provincial/
Grant Aid : Municipal Waterworks
(as of June 1998}
i6.4.3 LGV - Financed and - Discribe the Past Performance of WDS /
Managed Waterworks/ RWSAs/ B_WSAS
Water District
!
6.5 Existing Practices by the - Discuss LGU's means of cost recovery of i
LGU on Cost Recovery Capital Coss and O&M of Water Supply |
5.5.1  Capital Cost
6.5.2  Operation and Maintenance « Describes user's affordability by level of r
services .[
66  Affordability by Users ;
6.6.7 Capital Cost Contribution - Discuss user's WTP for water fees to cover T6.6.1  Affordability in Water and i
Q&M and Capital Cost Sanitation Services
* Questionnaire form Table- T, Figure-F
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Table of Contents

Contents
s

7.1

7.2

6.6.2  Qperation and Maintenance

Cost

WATER SOURCE
DEVELOPMENT

General

{1y Approach and Outputs

(2) Basic Data/Report with
Conditions

{3) Utilization and Up-
dating

{4) Existing Water Sources
in the Province

Geology

- Available water sources and their application

1o suit the locality
- Study approach with justification focusing

on groundwater
- Water Availability Map & standard well

specification”

- Major reports and hydrogeological maps used
as basis of the study (with conditions and
limitations} 7

- Effective data 1o supplement the base
materials’ i

- Manner of pﬁﬁt—put in PW4SP
- Updating methods clarifying what fzctors
can be modified and updated

- Description of existing water sources in the
provinee

- Geological Dismibution
- Technica! Information

Sources in the Province

F7.2.1  Geologic Map

Tables & Figures
Main Report Supporting Report Data Report
l\
i
il
|
i
b
i
i
|
ﬂ
I
ll
I
I
|
|
;
!
T7.1.1  Existing Groundwater T7.11 Water Source
Information |

* Questionpaire form

i,
i‘r

Table- T, Rigure-F




Li-c

—

Table of Contents

Contents

Tables & Figures

Main Report

Supporting Report

Data Report

7.3 Groudwater Sources - Classification of Groundwater Availability T7.3.1  Major References !
- Groundwater Availability in the Probince i
7.3.1  Classification of Groundwarer ~ Grounwater Quality T7.32  Well Inventory }
Availability by Municipality
7.3.2  Groundwater Availability in F7.3.1  Groundwater Availability Fi.i Work Flow of Groundwater [77.3.3  Water Quality
the Province Map Availabitity Map Analysis Data
F7.32  Groundwater Quality Map  [F7.3.2 Groundwater Potential Area
i
F7.33 Potential Area of High :
Yielding
F7.34 Area Category by Ground-
water Utlization
7.3.3  Groeundwater Quality
i
7.4 Spring Sources - Distribution of spring sources T7.4.1 Existing Spring Sources f
- Technical information
7.5 Surface Water Sources - Major rivers in the province T7.5.1  Surface Water Quality T7.5.1 Gauging Station & River {
- Technical Information Water Use by Major River I
Basin :
;
F1.5.1 Gauging Station & River T7.5.1  Suface Water Quality
Water Use by Major River
Basin ;
F1.52 River Flow Duration Curve
T7.52 Probability of Surface Water E
{ i
|
Table- T, Figure = F
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- Provincial sector targets in context of the
National Scctor Master Plan and the
Nationa! Medium-Term Development Plan

- Population to be served by target year based
on the NSO population projection and
broken down to urban and rural areas at
municipal levet by sub-sector

- Public school students 1o be served by target
year based an projected school cnrollment
atmunicipallevel... . -

« Projected number of public utilities with sani-
ary toilets by target year at municipal level

Table of Contenty Cantents lain Report Supporting Report Data Report :
+
7.6 Future Development - Potential water soutces in the provinces T.61  Groundwater Development  |T7.6.1 Existing Weil Sources £7.6.1  Individual Well Loca- |
Polential of Water Sources standard specifiations for preparation of Potential in the Provinee tion and Specifications
Medium -Term development plan. T7.6.2 Hydrological Description Map
Additional detailed developmet plan for T7.6.2 Spring Deveiopment by Municipality
groundwater and spring sOUrces. Patential in the Province
T7.63 Untapped Spring Source
F7.6.1  Individual Well Allocation Identification
and Specification Map
7.7  Water Source Development T7.7.]  Standard Specification of T7.6.3 Untapped Spring Water
for Medium <Term Wells by Municipality Source Idenufication {
Developmnet Plan _
T7.72  Additional Detailed T7.1.1 Spacing Arrangements for
Groundwazer Investigation Planned Weils
|
i
8. FUTURE REQUIREMENTS [
IN WATER SUPPLY AND
SANITATION IMPROVE- " !
MENT
8.1  Generl (1) Physical targets

= Questionnaire form

Table- T, Figure - F
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(2) Physical requirements
- Required facilities classified by urban and
rural areas by sub-sector with implementa-
tion criteria
- Equipment for.construction, rehabilitation i
and Q&M be identified
(3) Identification of priority projects
- Criteria for identifying priority projects i
- Priority projects by.sub-sector I
82 Targets of Provincial (1) Percentages of beneficizries or utilities 1o be T8.2.1  Provincial Sector Targets T8.2.1 Zstimation of Base Year |
Sector Plan served as target indicator Service Coverage of Water J
Supply ;
i
{2) Setting up of provincial sector trgess by T822  Estimation of Base Year T§22  Population Coverage in
sub-sector Service Coverage of Water Phase ] Provided by Served
- Water supply - Supply Population in the Base
- Sanitation T§.2.3  Base Year Service Coverage Year (Water Supply)
- Sewerage of Household Toilets
- Solid waste T8.2.3 Number of"Houscholds
T8.2.4  Base Year Service Coverage Served by Sanitary Toilets
of Public School Toilets in the Base Year (1995) !
and Public Toilets ‘r
) T8.2.4 Number of Public School i
TR.2.5 Base Year Service Coverage Students Served by School |
of Municipal Solid Waste Toilets in the Base Year ;
System in 1995 (1995) [;'
T8.2.5 Number of Public Utilities i}
with Sanitary Toilets in |
the Base Year (1995)
T8.2.6 Househeld Coverage in
Phase I Provided by Exist-
ing Facilities in the Base |
Table- T, Figure - F
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Table of Contents

Year (Houscholg Toilets)

T8.2.7 Public Schoo! Students and
Public Utilities Coverage
in Phase I Provided by
Existing Facilines in the
Base Year

8.3.1 Population Projection

(1} Methodology for population projection by
urban and rural areas by municipality

T8.3.1

Future Population by Urban
and Rural Area by Munici-

T8.3.1

Past Population Develop-
ment

.

0T-¢

- Basc figures and conditions: 1990 popula- pality
tions eensus and {uture population by urban .
and rurai areas by municipality by target year
as projected by NSO

- Review/verify past population development
characteristics by urban and Tural areas at
regional and provineial level

- Review/compare past population in urban
and rural areas at provineial level

- Identify areas/municipalities where adjust
ment 6f projected population is necessary

- Identify arcas/municipalitics 1o be exchaded
from PWasp .-~ 7 '

- Establish future population of urban and rural
arcas by municipality. by target year for

T8.3.2 Population Distribution in
Urban and Rural Areas
(1995 Census)

T§AZ Growth Rates and Population
Projection for Target Years:
Region and Province

T8l Provincial Pepulation for the
Base Year and Target Year

T8.33 Projected Number of
Households by Urban and
Rural Area by Municipality
by Targe: Year

{1} Methodology for school enrollment projest- - |T8.3.2  Projected Public School TE.3.6 Projected School Earoll-

§8.3.2  School Enroliment
Projection ion by municipality * . o Enrollment and Number of ment by Municipality by
- Determine school age population Public Utilities by Munici- Target Year
- Determine participation rate.of total school paliry .

enrollment and participation rate of public
schoo! enroliment > S
- Establish future panicibariori rate of total
school enroliment and participation rate of
public scheol enrollment =~ -
Table- T, Figure - F
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$.3.3  Projection of the Number - Conditions used for f:rojcclion of the number T8.3.7 Projected Number of i
of Public Unlities of public utilities toilets Public Utilities by Munici- |

pality by Target Year
%.3.4 Plaaning Area and its Projec- - Conditions used 10 define planning area and r
ted Population for Sewerage population to be served \;
, .i
8.3.5 Number of Houscholds to be - Condition used to determine population to E
Served by Municipal Solid be served ’ i
Waste Collection System ,I
. i
8.4 Typesof Facilitiesand |
Implementation Criteria ‘

8.4.1  Water Supply - Classification of service fevel by urban and T8.4.1  Potential Water Seuree for  [T8.4.1 Rapid Evaluation of Un-
tural arca Urban Water Supply tapped Spring for Use in
- Optimum number of persons 10 be served Urban Water Supply
by type andn level of service T84.2  Groundwater Productivity

- Limited utilization/application of Levels | FE.4.1 Typical Structure of Levei I r
) : T8$4.3  Standard Specifications of Well Fagility i
!

8.4.2 Sanitation

& 11 gysterns
- Rehabilitation/replacement of Level |
facihities

(1) HH wilets: One sanitary toilct per house-
hold is considered. Type of facility is
dependent on the existing or planncd water
supply level of community

(2) School and public-utilities wilcts
- Future assumption on the number of public
schools/utilities toilets
- Standard DECS coverzge based on a 1:50
facility-student ratio will be followed and the
standard designs of RESP will be adopted.

Level I Wells

* Questoanaire form
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8.5

Table of Contents

8.4.3  Urban Sewerage

844 Solid Waste

Service Coverage by Targer
Year

1 Water Supply

8.5.2 Sanitation

Contenty
ENFEENE

- Standard FW4SP designs (with modification)
for public toilets will be adopted

- Staged implementation of the sewerage
program for linmited urban area,

- Requirement of garbage collection trucks is
considered, .

(1) Assumptions/conditions adopted
« Criteria on namber of persons served by
type and level of service through the future
- Limited utilization/application of Levels |
& 1! systems

(2) Additional population to be scrved by
target year
- Present population served in urban and
rural areas at each municipality {19935)

(1) Houschold toilets :
« Present household served by type of toilet -

facility in urban and rural areas at rmunicipa! -

level (19953 . ) .
- Households to be served by type of toilet

facility in wrban and rural areas at municipal

T8.5.1

T8.52

Population to be served by
‘Targer Year (Water Supply)

Additional Number of
Households to be Served
by Target Year (House-
hold Foilets)

F8.4.2

TB.5.]

T8.5.2

T8.5.3

T3.5.4

18.5.5

Staged Improvemnent in
Sewage Collection Method

Population to be Served by
Level {1 Systam in Phase ]

Population to be Served in
Phase I (Water Supply)

Population to be Served in
Phase [I {Water Supply)

Additional Number of
Houscholds to be Served in
Phase I (Household
Toilets)

Addrtional Number of

* Questicnnaire form

leve) by target-year R Housgholds to be Served in
= Additional houscholds 10 be served by type Phase II (Household
of wilet facility,in,urbm_l and rural areas at Tailets) '
municipal level by target year
Table- T, Figure - F




£C- T

* Questivnpaire form

Tables & Figures
Table of Contenity gnnsﬂm Main Report Supporting Report Data Report
{2) School toilets H |
- Present number of public school students T8.5.3  Additional Number of Public |T8.5.6 Additional Number of '
adequately served at municipal level {1995) School Students to be Public School Students to |
- Number of public school students 1o be Served by Target Year be Served in Phases [ and
served at municipal Tevel by target year (Sehoo! Toilets) 11 (School Toilets)
- Additional public school students to be
served at municipal level by target year T8.5.7 Additional Number of Public f
L , . Utilities with Sanitary Toilets 'j
(3) Publicroilers. . T$.54  Additional Number of Pub- in Phases [and I ;
- Present number of sanitaty public wilets at lic Utilities with Sanitary 5!
municipal level (1995)° Toilets by Target Year i
- Projected number of sanitary public toilets
at municipal level by target year
(new construction}
- Additional public teilets at municipal
ievel by target vear
3.5.3  Urban Sewerage - - Assumptions adopied to define service T8.5.5 Population to be Served by
coverage o Urban Sewerage in Phase II !
- Population to be served by target year (2010) {}
|
8.5.4 lid Waste - Assumptions adopted to define service T8.5.6  Additiona) No. of Urban :
coverage Households to be Served !
- Addtional number of households 1o be served by Municipal Selid Waste g
by the municipal system by target year Systern in Phase [ :
(2000) !
8.6  Facilities, Equipment and
Rehabilitation to Meet the
Target Services
8.6.1 Warer Supply {1 Water supply facilities by service level by T8.6.1  Water Supply Facilities T8.6.1 Urban Water Supply !1I
target year Required by Target Year Facilities Required by ;
Target Year ;
; |
Table- T, Filgure- ¥
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8.6.3  Urban Sewerage and Solig
Waste

87  ldentification of Priofity
Projects for Medium-Term
Development Plan

- Additional units of truck required to meet
service coverage
{1) Criteria for identifying priority projects

(2) Description of identified projects by mode
of service in cach sub-sector

T8.6.3  Number of Garbage Collec-
tion Trucks Required in
Phase |

Table of Contents Conrents Vain Report Supporting Keport Data Report i;
(2) Equipment: T8.6.2 Plan for Expansion of
- Well drilling equipment for waler source Existing Level III System |
development |L
- Workshop bldg., and its equipment/tocls T8.6.3(a) Rural Water Supply Facih- 11
- Major transportation equipment for cons- ties Required by Target )
ruction and Q&M Year
f
{1} Renabilitation T8.6.3(b) Public Facilities Required by |
- Wells and handpumps Rura! Water Supply by
Target Year
|18‘6.2 Sanitation - Urban houschold toilets required by arget TX.6.2  Sanitation Faciliuies Required T8.6.4 Urban Houschold Toilets !
year by Target Year Required by Target Year
- Rural household toilets required at municipal
level by target year T8.6.5  Rura! Houschold Toilats 3
- Public schoo! toilets required at municipal Required by Target Year
level by target year . :
- Public toflets required at municipai level T3.6.6 Public School Toilets h
by target year Required by Target Year E
: \
T8.6.7  Public Toilets Required by f
Target Year ?‘
I

* Questivonaire form
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0. )
SECTOR MANAGEMENT
FOR MEDIUM-TERM
DEVELOPMENT PLAN
9.1 General
9.2 Sector Management - Situntional Analysis: Developing the Vision F9.2.1  Sector Management Model
- Serviee Provision Policies and Objectives
- Operating Policies
- Regulatory Policies
- Finamcing System
9.3 Institutional Arrangements ;
9.3.1 Roles and Responsibilities of
Agencies Concerned
9.3.2  Instiutional Arrangements F$.3.1  PWSO in the Province
9.4 Project Management - Level ;
Arrangements - LevelIT
- Level Il ;
9.4.1  Project Approach/Strategy F9.4.1 Project Implementation :
Amangement and Procedure
(for Water Supply i
Component) i
F3.4.2 Project bmplementation
Arrangement and Procedure
{for Sanitation Component)
0.4.2  Project Implementation = Level | i
Amangement - LevelII \
- Level It
|
;1
* Quesnonngire form Table= T, Figure=F
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9.5 Community Development - Policy, respounsibilitics on CD/CO

- Policy, responsibilities on [EC

- Policy on Gender Responsive Projects
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facility) by type and leve) of service based
on: .

- Existing standard unit costs of sector
agencies concerned (DPWE, LWUA and
DOH;)

- Typical standards devetopment for PW4SP
(i.c., deep wells by different depths)

{2) Unit ¢osts of equipment based on the stan-
dard unit cost and recent procurement
record at sector agencies concerned
(DPWH, LWUA, DOH)

(3) Sector nmagcnicnt cOsts
Establish percentages 1o base cost or unit

cost for following sector management
acuvities: ° ‘

and Vehicle

(Deep Well - 40m Depth)

T10.2.2(p) Unit Cost of Level I
(Deep Well, Natural Gravel)
Pack - 20m Depth)

T10.2.3(a) Limit Costof Levell
Deep Well - 80m Depth)

T10.2.3(®) Unit Cost of Level 1
{Deep Well, Nawral Gravel)
Pack - 80m Depth)

Ti0.2.4{a) Unit Costof Level ]
Deep Well - 120m Depth)

Table of Contents Contents Main Report Supporting Report Data Report
10.  COST ESTIMATYES FOR
FUTURE SECTCR
DEVELOPMENT
10.]  General (1) Methodology adopted to cost estimates
{2) Composition of ¢ost estimates |
- Costs for required facilities by urban and lJ
rural areas at municipal level together with t
equipment for construction/rehabilitation :
and O&M
- Costs for sector managerent and recurrent
costs
10.2  Assumptions for Cost (1) Unit Cost of facilities T10.2.1  Unit Cost of Facilities by T10.2.1  Price of Major Materials by
Estimates Type and Service Level Fagility
Establish unjt cost (per capital/HH or i
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Trial Allocation of Intemal
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Allotment for Medium-
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IRA to the Relevant Sector
by Component, 1999-2003

Financing Requirements for
Sector Component for the
Province
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Investment

* Questionnaire form

Table- T, Figure « ¥




t-2

iv:? .

Tables & Figures

Municipalitics

Table of Contents Contents Main Report Supporting Report Data Report
114 Medium.Term Implemen- -« Implementation arrangements with available Tii4l  Comprehensive Investment
tation Arrangements funds for relevant sector Need Ranking of the i
Municipalities |
1i.4.1 Relcrence Scenarios in - Trial caleulation on the allocation of pro- Fil4.] Relationship Between Fund- |
Different Funding Levels Jjected [RA to municipalities for Medium- ng Levels and Percent of
Term Development Coverage for Water Supply i
Sector .I'
F11.4.2 Relationship Between Fund- e
ing Levels and Percent of |
Coverage for Sanitation I
Sector "
11.4.2 Alternative Counter- - Acquisition of external funds T11.4.1 Municipal Investment Need
measures - Augmentation of sector finance Ranking for Urban Water [
- Private sector participation Supply |
- Effective and economical investment
T11.4.2 Distribution of Provincial I
IRA to Municipalities for )
Usrban Water Supply !
i
T11.4.3 Municipai Investment {
Need Ranking i
|
1i.5  National Geverment - Level 1 WaterSupply and Sanitation
Assisted Level/WaterSupply improvement with pessible assistance from "
and Sanitation Project GOP i
[
11.5.1 Project Components - Level | WaterSupply and Sanitation System T11.5.1 New Cost Sharing Arrange- (T11.5.1  Available IRA for GOP- i
in the rural area { 5th and éth class ment between NG and Assisted Level 1 Water and ;
municipalities ) LGUSs Rural Sanitation Project for i
Eligible Municipalities i
11.5.2 Project Requirements = Arrangement to meet NEDA requirements T11.5.2 Cost Sharing for the ,l!
Project (Case 1) TI152  Available IRA for GOP- h‘
1997 price level Assisted Urban Sanitation I
Project for Eligible ]

* Questicnnaire form

Table- T, Figure« F



it-c

Tables & Figures

Table of Contents Contenty Main Report Supporting Report Data Report |
il
11.5.3 Funding Requiremets - New Cost Sharing Policy end Financial Ti1.53 Cost Sharing for the Ti1.5.3  Total Available IRA for i
Viability Project (Case2) GOP-Assisted Level ] !
) - Water Supply and San:tation i
11,6 Cost Recovery . Discussion on cost recovery and cost sharing Til.4  ODA-Assisted Rural Water Project :
to attain planned targets Supply and Sanitation !}
Project Cost T11.54  FIRR for Level I Rural i
Water Supply '!
T11.8.5 Available IRA for ODA- :
Assisied Rural Water ’
Supply and Sanitation |
Praject for Eligible i
Municipalitics 5
T11.5.6 Available IRA for ODA-
Assisted Urban Water i
Sanitation Project for 1
Eligible Municipalities
W+
T11.5.7 Total available IRA for
ODA-Assisted Project
i
11.6.1 Q&M and Cost Recovery T11.6.1 Investment Program TIL6l  Investment Program of ;
for the assisted Water . . GOP-Assisted Level | ;
Supply and Sanitation T11.6.2 Q&M cost for Level ] Water Supply and Sanitation |
Project Factlities Project :!
i
T1163 O&Mocostper HH/Month  |T11.62  O&M Cost for Level I i
by Facibility.and Propor- Facilities
tion to Monthly Family . !
Tngome Til63  O&M Cost per HH/month i
by Facility and Propartion to i
Til.64 Family Income Monthly Famsly Income f
Ti1.6.5 O&M Cost for Rural TIL.64  Femily Income- ?
Sanitation TI1.6.5  O&M Cost for Rural |
Ti1.6.6 O&M Cost for-Urban + Sanitation ’ "
Sanitation - o
* Questionnaire form Table- T, Figure« F
fa " . ﬁ :':I




Le-1

Tubles & Figures |
Table of Contents Contents Main Report Supporting Report Dats Report
12. MONITORING FOR
MEDIUM-TERM -
DEVELOPMENT PLAN
12.1  Gengral i
12.2 Sector Monitoring - Monitering activities with responsibilities Ii
in different administrative levels !
123 Project Moniloring . Monitoring activities at project level |
12.4  Evaluation of Plan Imple- - Manner of follow-up and feed-back in plan- T12.4.1  Draft Formats for Annuai Ti24.1 Draft Formats for
mentation and Updating ning and project implementation Sector Performance Sum- Annual Sector Perlor-
the PWASP mary Report (Provineial mrance Summary Report
and Municipal Levels) (Provincial and Munici-
pal Levels)

* Questivapaire form

Table- T,

Rigure =« F



ANNEXT User’s Guide for Computer-Aided Plavning

1.

INTRODUCTION

The PW4SP Data Management User's Guide explains the procedure of encoding data and

gencrating table

’ Section 2;

] Section 3;

. Section 4:
v Section 5:

. Section 6:

€ Section 7:
. Section §:

. Section 9:

s and figures for the PW4SP, The Guide consists of the following sections.

hardware and software required to successfully run the PW4SP Data
Management System

the concept of the microcomputer architectute and an overview of hardware
configurations

fundamentals {0 operate the system with internal architecture
basic concept of sofware operation

a complete list of data files and worksheets in the PW4SP Data Management
System

data linkages
the procedure of updating the PW4SP

standard report forinat

SYSTEM REQUIREMENTS

The following are the basic requirement to successfully n the PW4SP data AN e,

Hardware:
Computer:

RAM:

Hard Disk:

Floppy Drive:

Montitor:

Printer:

Mouse:

Miscellanecus:

Sofiware;
80486 CPU a1 66 MHz Operating System: DOS Ver, 6,22
& MB {minimum) WindQWS Environment: MS-Window Ver 3.11
200 MB (minimum) Spreadsheet: MS-Excel Vor 5.0
3.5 inch. High Deasity Word Processing: MS-Word Vers 0

5.25 inch, High Density
VGA Monitor

80 column

(Can handle A4 size paper).
Any brand which supported
by MS-Windows

300 watts Automatic Voltage

Regulator and Surge Protecior




MICROCOMPUTER SYSTEM

All coruputers, whether large or small, basically operate on the same fundamental principles.
The hardware and software of a mainframe computer and a miceocompuler have the sarae

components and fulfil the basic functions necessary to any computec system.

The computer is seen as a powerful toa! that can enable us to expand the horizons of our
knowledge. It allows processing of large volume of data or complex pattemn of information
that would otherwise be difficull to organize and understand. Moreover, it allows for an

easily manipulation of data.

There are two major components of a microcomputer: the hardware and the software. These

1wo components complement each other in order to fulfill their basic function.

A microcomputer hardware is made up of several components based on the functions they

perform in the system and how they interact with the other components.

The principal elements of a computer system are:

» Central Processing Unit (CPU)

« Main Memory (RAM)

« Secondary Storage Devices (disk, drives, magnetic tapes, etc.)
« Input/Output Devices (terminals, printers, etc.)

The CPU does the actual computing. It is capable 0} simple arithmetic and logical
operations, such as addition and data comparison, that are executed at exceedingly high
speed. The power of a computer directly stems from the speed and accuracy with which the
CPU can camry out computations and move information around. The main memory of the
computer is usually referred to as Random Access Memory or RAM. This pant of the
computer contains the programs and information that are currently being processed by the
CPU. Secondary storage devices, such as magnetic disk, is capable of holding large amount
of data. Programs and data are normally stored on these secondary devices and could be
retrieved when needed. They are then loaded into the RAM and executed. The resﬁlts of the
processing can then be wrilten into the secondury sterage device or sent to an ouiput device
such as the monitor or printer. Peripheral deviécs or [nput/Qutput (/Q) devices allow the
user to put data into a computer or receive oulput from a computer. A terminal is a

peripheral that contains both a keyboard for input and a monitor for output. Other

peripherals include printers and plotters.
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The diagrarn below presents the basic hardware component of a microcomputer system.

Central Processing Unit

(CPU)
/O Terminal l Secondary Storage l
i ,
Random Access Memory
Keyboard (RAM)
L¢p»] Hard Disk
Monitor |l
L& Floppy Drive
Printer - T

Floppy Drive is the most common type secondary storage used in personal computer today,
It acts as an extemal drive from which the users insert the' ﬂop’py'disk to store and retrieve
information. The floppy disk comes in three sizes: 3.5 inches, 5.25 inches and 8 inches. It is
characterized by thin circular plastic sheets coated with iron oxide so that magnelic patterns
recorded on it can be retained. The surface is similar to 2 magoetic tape used to record
music. The disk is contained in a square cardboard envelope in which it spins. The 3.5
inches diskette is contained in a hard plastic case with a metal shutter that protects the
magnetic media. A floppy disk can store from 80 kilobytes to 1.44 megabytes of data.
Floppy disk system is slower and has less storage capécity than hard disk system, but its

lower cost makes it a popular choice for personal computer,

Hard disk is made of magnetic metal, and can either be removable or non-removable. The
most common type of hard: disk found in personat computer today is non-removable. This
disk typically helds from 10 meagabytes o L5 gigabytes of information. Each megabyte is
equivalent to 1,048,576 characters of information, or roughly 1,800 single-spaced typewritten

pages: hence, this is a very efficient way to store large volume of information.

Keyboard is an external device that acts as a primary intetface between the human operator
and the computer. The keyboard has 3 busic components: the typewriter keyboard which is
composed of alphabet characters; the calculator pad which is composed of numeric

characters; and the function keys which serve as special macro key for various softwares.
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Monitor is the screen or video display peripheral and serves as the main output device on a
pecsonal computer. It is used to display text and geaphics information and is available in a
variety of sizes and types. Monitors can be divided into two broad groups: those designed to
display text information; and those designed to display graphics information, such as charts
or picture. Within the graphics group, there are color or monochrome (single color) displays.
A high quality graphic color monitor is capable of showing high resolution pattern and is

recommended for application in MS-Window, Excel, or AutoCAD,

Printer is another common peripheral found in personal computer system. The 2 common
type of printers are dot matrix and laser printer. The dot matrix printer produces its image by
printing a group of dots that forms the image of a character or symbol. Several methods are
used to create the paticm of dots. The most common are impact, thermal, and ink-jet

technologies. The laser printer produces its irmage by means of electrophotograph similar ta

the principle of photocopy machine.

OPERATING SYSTEM

AR operating system is a set of control program that manages the computer's resources and
create a well-defined software enviconment for computer applications. Computer hardware
by itself can perform little useful work. A computer requires a software to be able to

communicate and do useful work. The first layer of software in a compuler system is the

operating system. This is what starts, or boots up, the machine helps in pulling itself up by

its own bootsteaps and establishes a predetermined set of conditions so that applications can
be tun. When' the camputer is turned-on or the reset button 'is pressed, the control is pass to a
set of contral programs found in the ROM; a firmware store in computer chips. These
programs pecform several tasks: '(l) to check 1f hardwares are functioning correctly; (2} to
load a set of control program from the disk to the memocy; and (3} to pass cantcol 1o a coutine
which wili accept the user input. At this painf, the operating system is loaded and the user

can execute an application piogram such as MS-Windows, MS-Word. or Excel.

An operating system by itseif has two levels of functionality. The first level is seen by the
user running the applications and utilizing system commands and utilities. At this level, each
operating system has its own set of command used to accomplish frequently performed tasks
such as copying files, renaming files, and formatting disks. Normally, frequently-used
functions are included in the operating system as system commands. The second is at the
programming level. Al operating systems contain a set of pre-packaged routine which

perfoans the “primitive” functions necessary in almost all applications. Such functions, like

2-37



5.1,

sending a characler to the screen, reading and writing information from a disk file, and
accepting input from the keyboard are common to nearly all programs. ‘This level of

functionalily gives the programmer a set of standardized routines to perform this task.

Opecrating systems, such as DOS or UNIX contain many uscfuel utilities and provide a rich set

of function, which simplify the programmer's job writing application and controlling the
hardwares.

SOFTWARE

The operating system alone renders the computer nearly useless, unless the user is capable of
directly communicating to the hardware. I[n order to use the compuler system, a sofiware. is
needed. Various softwares are available for different purposes, such as MS-Word for word

processing, Exce! for spreadsheet and Foxpro for programming.

MS-WINDOWS

MS-Windows is a popular software that duplicates the function performed by DOS at the

system level. Most of the commands are represented by descriptive figures called icons.
Navigating around the windows is through a pointing device called mouse. To execute a
comméhd, the user only need te bring the mouse pointer to the desired command described
by the icon and press the right bution. The execution starts without lyping any single
character in the keyboard. unlike the DOS canvention that needs typing a series of characters
comprising the filename. In windows, the computer screen is referred to as the desktop.
When working, the application and documents must be in the windows. The windows on the
desktop must also be arranged. If an application is ieft fora whilé. the windows are shrunk to
an application icon, and still, the application keeps running on the background. When an
application is shrunk, the windows place iheir application icon at the bottom edge of the

desktop until it is again restored to window size.

With windows, several powerful applications can be run simultancously. For example,

switching from a word processing application to a spreadsheet, and then to database

applicatton with a few simple moves white quitting one application and restarting another,
can casily be dope.
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Two Kinds of Windows

Application windows contain running applications. The name of the application, the
associated document, and the application’s menu bar appear at the top of the- application
window. Application windows can be positioned anywhere within the desktop borders.

Document windows appear only with application that can open two or more documents at one
time inside the same workspace. For example, with Windows File Manager, one can open a
number of directories at the same time. Each directory appears in a separate document

window (called a directory window) in the File Manager wotkspace.

Parts of a Windows

Each application and some documents the user choose (o work on, open as separate windows,

Every window has some common elements, howeaver, not all windows use all the items.

The elements as iltustrated below are the tools for working with the window and the

application or document within the window.

{nsation paint Window title Minimiza bution

Control-manu box Title bar Maximize buttan
= R e e e T
VFile Edit Sceech Hedp . Menuy bar
-\l <}
]
[
T — Windaw borcer
- Vertical
scrall bar
! (4]
L | N N | 3
\ Windaircomer \- Mayse pointer \ Horizontal sceoli bar

The Coutrof-menu box located in the uppec-left camer of the window is the most yseiul
menu whea the use of a keybouard is preferred. The Control-menu commands can resize,

move, maxinvze., minumze and close windows. and switch to Task List,



The title bar shows the name of the application or document. If more than one window is
open, the litle bar of the active window has a different color or intensity compared to the
other title bars.

The window title. depending on the type of window it appears, can be the name of an
application and the name of the document, or a placcholder. In such case, “untitled”
normally appears.

The menut bar lists the available menus. Most applications have a File menu, an Edit menu,

and a Help menu as well as other menus unique to the application.

The Scroll bar can move the parts of the document into view when the entire document witl

not fit in the window. With the bar, unseen portion of the lists and other information that is

too long to fit in the allotted space can also be viewed.

The Maximize and Minimize buttons enlarge the active application window to fill the entice
desktop or shrink the window to an icon. Document windows enlarge just to Rl the
application workspace and not the entire desktop. After enlarging the window, the Maximize

button changes to a Restore button. Restore button can be used to return the window to its

previous size.

The Window border is the outside edge of a window. It can lengthen or shorten each side of

the border.
The Window corner can be used to shorten or lengthen Lwo sides of a border at the same time.

The Workspace is where most of the work with an application are done. For example. the
content of the documents appears in the workspace when starting a wordprocessor. Hence,

an application can allow the opening of more than one document window within this

workspace.

The selection cursor shows where the user is in an individual document. It marks the place
in the text or graphics where the user begins typing or drawing. The amow-shape mouse

pointer appears if you bave a mouse installed. It is used to indicate items the user wanis to

select with mouse.
Starting Windows

At the DOS prompt, type win and press ENTER,
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When starting windows, the Program Manager window is antomaticatly opened with the
Main Group window opening inside it and other window groups represented as goup icons
located at the lower edge of the Program Manager window as show in the illusiration in

below.

Wirdowt 7 S ArriMs
§eto

AgCerons Games Sixllp Aochc siors

Quitting Windows

Mouse 1. Quit any application that are currently running.
Click Program Manager's File menu to open it.
Click Exit Windaws.

The Exit Windows confirmation dialog box appears.
4. Click OK 10 exit windows,

w

Keyboard I. Quit any application that are curcently running.

' Press ALT-F to open Program Manager's File Menu.

. Press X (the underlined lewer in Exit).

Or use amow key to move the highlight o Exit Window
and the press ENTER.

3. The Exit Windosws confirmation dialag box appeas.

4. Press ENTER to choose OK und exit windows.

IQ

Starting Window Application
To make starting application easy, Window offers three niethods:
Choose a program item from a group window in Program Munuger.

Choose a program file from the appropriute directory window in File Munager.

Choose the Run command fram the File menu in Program Munager or File Muanager.



© Starting Applications from Program Manager

As long as an application belongs to a group, the easiest way to start is o choose from the
grovp window. If a document is included with the application, it will be loaded into the

application workspace.

Mouse L. Open the Program Manager window. if not already open,

and open the group window thal contain the application
yOu want to start,

2. Double-click the icon for the application.

Keyboard I. Open the Program Manager window, if not already open,

and open the group window that contain the application
you want to start,

2. Use the arrow keys to move the highlight to the icen for
application,

3. Choose Open from the File menu and press ENTER.

Starting Applications from File Manager

You start an application from File Manager by opening the program file from a directory
window. You can execute an application program file having .COM, .EXE, .PIF, or .BAT 3

filename extension. If the application can run in a window environment, the window will

appear in front of any File Manager windows that are open.

Mouse 1. Start Fite Manager and open the direciory window
that contain the program file.
2. Double-click the filename.

Keyboard I. Start Fije Manager and open the directory window
that contain the program file.

- Use the amow keys to move the hightight 1o the icon for
application.

3. Choose Open from the File menu and press ENTER,

L}

Starting Applications with the Run Command

The Run command is a handy way to start applications that you want to run only occasionally
or have not vet added to a group. You can open a document at the same time you start the
application. Unless the pragram file is in your current path, you need to know the exact

directory tocation and name of the program file before you can start the application. l

L. Cheose Run from the File menu in Program Manager or File Manager.
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The Run diatog box appears.

2. Type the pathname and the exact filename of the program file, including
the extension if there is one,

3. If you want the application to shrink to an icon as soon as il starts, make
sure the Run Minimized check box contain an X.

4. Choose QK or press ENTER.

MS-EXCEL

Excel is a spreadsheet type of software package that operates under the MS-WINDOWS
operating system. The primary document in Excel is called a workbook. The workbook is
sirnilar to a ledger that stores information and each workbook is made up of sheets. The
sheet is virtually divided into column and row; the column run horizontally and denoted by an
alphabet starting with A and the row run vertically and denoted by number storting from |,
The intersection of column and row is called cell. The cell is the basic component of
worksheet that accept diffecent data types. The most common data types are character,

number, date, logical valug and formula.
Standard Toolbar
The standard toolbar that normally appears at the top of screen helps select options. Such

options can open workbook, print and save worksheet, and ask for help. The following is a

fist of the individual icons and their respecitive funciions.

Excel’s Stondard Toolbor

Buton Name Funchon
New Workbook Creates a new werkbook
Open Opens a document

E;a Save Saves the acive workhook

&
Print Prinw the active warkboek

@ faint Preview Shows the actve document in print preview

maode




Excel’s Stondard Toolbar

Bution Nome . Function
_'ié_, Speller Checks the spelling of the dotumenc
5 -
= Cut Cuis the szlecdon to the Clipboard

3
- Copy Copies the selecdon to the Clipboard
'ﬁ Paste Places the Clipboard contenus at the iaserion
. poing
‘—'-vE
— Format Painter Copics and pastes formats for cells and objecu
Ca
Wy :
b Undo Undoes the Tast 2¢iion or command
5@; '-: Repeat Repeats the ast action or commaad;
: this is the same a5 the redo feawre in Word 6
..’Z,‘
e AutoSurn Insects the SUM funceion and shows sum range
&)
o e _3 .

— Yuncdon Wizard Suares the Funcdon Wizard
T
Z Sort Ascending Sore selecied rows in ascending order
Rl
A Sort Descending Sorus seleceed rows in descending order
K

ChartWizard Acdvares the ChariiWizaed
= Text Box Iiseets texcor text hax
nm Ocawving Turns e draning toothar an or off
ife—
100% e :
= Zoom Control  Sews the view of the dacuinient

r-—_a;.
k=Ll Tip Wizard Tuwrns the TipWizard toolbar on or off

oy
. ? Help Displavs Help
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Excel’s Formotting Toolbar

8otion Nome Fonction

Arial g

=Y Fom Sets the font for the selectan

10 I ' Fant Size Sews the font size for the
! ) selecuion

ey

:Jv}-}‘ * Bold Boldfaces the selection
g

I3

Wl | Ttalic Italicizes the selecdon
S
22 Undedline Underlines the selecdon
bt Align Left Leftaligns che selecdon

Center Centers the selecdon

Aligee Right  Rightaligns the selection

ST . Center Accoss  Centers the selecdon acrass
= Columns columns
Eﬁ;’ Currency Changes the selected eells to
RN Soyle . default curvency sote

] EB/’G.“ Percent Changes the selecced cells to
o Sele defaule percenusnle
SFE Comma Changes the selected cells to
=3 Sgle defauli comma sole
_;'_-".'0 Increase Adds one decimat place o

=0 Decirmal the number format

103 _ . Decrease Removes one decimal place
1 Decimal from ‘the aumber forinat

Borders Enables you to sclecta
border for the sclection -

]
141

zt:l“' '_"’ Coloc Seis the color foc the

i el selection

’E 11 Fone Color Szu the color for the setected
% X font i
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Basic Part of Excel Screen
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MS-Excel Basic Operation Tobs Workiheat

Following the description of the basic operation, the mouse is used as a peinting device

instead of a keyboard. The word click means the vser must press the left buton of the tg
mouse; double click.teans two successive clicks; and enrer means the usec musi press the

Enter key in the keyboard. Basic operation dealt only to the routine neceSsary to update the

PW4SP data base.

Creating a New Worksheet

Whea you enter Excel. it opens up 10 a new workbook, by def.luh it contain 16 worksheats.
You can use any of the worksheets. Even if there is an open workbook. you can still open

another by moving the mouse pointer in the New icon (uppcr left of the screen below the

menu bar). Click on .

Saving the Warkbook

I. Move mouse pointer to File menu wnd click on it to bring the File menu option.
2. From the option available. Select Suve.
'.“

If the document your saving is new. The Save As dulog box appeur. In the File Name
box type the name of the workbook.

Enter Datain a Cell l
I. First select the coll by moving the mouse pointer und chieking the =

right button, This routine place the insertion point in the uctive cell,
which is highlighted ea-screen with barder around it
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Z, You can start entering the data from your keyboard or numeric keypad.
3. To confirm the input, you can press ENTER or move the mouse pointer
1o the Formula bar and click the Check icon.

Editing Cell Contents

i. Double-click the cell containing the data you want to edit,
To edit in the formula bar, click in the formuta bar. In case the formula
bar is not displayed, choose Formula Bar from the View menu located
at the top row of screen.

2. Edit the cell contents.

3. To confirm the modification made in the cell, click the Check icon in the
formula bar or press ENTER. To cancel edits, click the X icon in the
focmula bar or press ESC.

Clearing Cells

1. Select a cell or range of cells that you want to clear.

2. From the Edit meny, choose Clear, and from the option available,
you the choose All, Contents, Formats, or Notes.
Shortcut: Press DEL.

To ¢lear cells by dragging

1. Select a cell or range of cells that you want to clear.

2. Move the mouse pointer in lhéﬁ!l kandle (lower right comer),
drag the fill handle toward the arca of cell or cange, then the selected
area will become gray.

3. Release the mouse button.

Caopying Cells

1. Select the celis containing the data you want to copy.
2. From the Edit menu, choose Copy.
3, Select the upper-left cell of the paste area.
Beware thal any vatues or formula in the paste area will be replaced.

Undo Comm_and

l. To undo your last command, click the Undo bution.
From the Edit menu, choose Undo.

Creating Border around Cell

1. Chaose the Cell menu from Format menu. _
2. Choose the side you want put the border, und then choose type of border.
3. Click OK button.

Deleting Rows and Columns

|. Select the row or column
To delete more than one cow or column, extend the selection to include
all the rows or columns you want o delete,
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2. From the Edit menu, choose delete (Entire rows or column)
3. Click OK button

Inserting Rows and Columns

1. Select the row or column

To insert more than one row or column, extend the selection to include
the nurmber of rows or columns you want to insert,
From the Edit menv, choose Insent (Entire rows or column)

2
; Click OK button.
Selecting a Sheel or Sheets
To select a single sheet, click the sheet tab.
To select two or more sheets
1. Click the sheet tab for the first sheet you want to select.

2. If the sheets you want to select are adjacent, hold down the SHIFT key
and click the tab for the last sheel.

If the sheets you want to select are non-adjacent, hold down the CTRL key
and click the other sheet tabs.

Ungroup Selected Sheets

1. Move the mouse pointer to the sheet tab. Click the left buiton of the mouse.

2. While the mouse pointer stilt on the sheet tab, click the right button and
choose the Ungroup Sheets.

Inserting YWorksheet

1. Select a sheet or sheets in the workbaok.
2. From the Insert menu, choose Worksheet.

The new sheet or sheets will be inserted to the left of the sheet tab you select.

Shoctcut: SHIFT+F11

Deleting Worksheet

l. Select a sheei or sheets in the workbeok.

2. Move the mouse pointer to the sheet tab, and click the right butten.
3. Choose Delete, and click the OK button.

Moving Worksheet Within the Workbook

L. Select the sheet or sheets you want to move.

2. Drag the selected sheet tab along the row of tabs.
A black triangle indicates the place where the sheets will be inserted.
All selected sheets will be inserted.

3. Releuse the mouse button,
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Altemate Method

. Select the sheet or sheets you want to move,
. From the Edit meny, choose Move or Copy Sheet.

. In the Before Sheet hox, select where you want sheets to be inserted.
. Click the OK button.

fa Gl (nD e

Moving Sheets to Other Workbook

1. Open the workbooks you want to move sheets to and from.
2. Select the sheet or sheets you want to move.

3. From the Edit menv, choose Move or Copy Sheet.

4. In the To Book box, select the destination workbook.

5. In the Before Sheet box, select where you want the sheet or sheets inserted.
6. Click OK button.

Altemnative Method

—

. Open the workbhaoks you wén_t to move sheels (¢ and from.
2. From Window menv, choose Arrange and choase horizontal,
[n the deskiop, two workbooks will open in screzn split the workarea horizontally.
. Setect the sheet or sheets you want to meve.
4. Hold-down the CTRL key and the right button of the mouse.
A paper icon and black triangle indicate that you made the move routine active.

5. Drag the mouse pointer (o the other workbook and select where you want
the sheet or sheets inserted.

6. Release the mouse button.

()

Copying sheets within a wotkbook

{. Select the sheet or sheégs you want Lo copy. _
2. Hold down the CTRL key and mouse l2ft button, and then drag the selected

sheet tab along the row of tabs. A black triangle i'nc_Iicates the place where
the copied sheet will be inserted.

3. Release the mouse button and then the key.

Altemative Method

1. Select the sheet or sheats you want to copy.

2. From the edit menu, choose Move or Copy Sheet.

3. In the Befare Sheet box, select where you want the copied sheet inserted.
4. Select the Create A Copy check box.

5. Click the OK button.

Copying sheets to other workbook

. Open the workbook you want to copy to and from.

. Select the sheet or sheets you wani to copy.

. From the Edit meau, choose Move Or Copy Sheel.

. In the To Book box, select the destination workbook.

. In the Before Sheet box, select where you want the copied sheet inserted.
6. Select the Create A Copy check box.

7. Choose the OK Button.

Lh £a Led I e
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Prinfing your Work

L. From File menu, choose Page Sewp to display the Page Setup dialog box.
2. On Page Setup dialog box, their are four option available

Page 1ab controls page grientation, scaling, page size, print quality, and
starting page number for the selected sheet,

Margin tab controls page margins and the header and footer margins, and
center the sheet on the page vertically, horizontally or both.

Header/Faooter 1ab coatrols page the headers and foole_rs__for the selected sheet.
headers and footers are descriplive text that print at the top and bottom of
every page in your sheet. You can add, delete, edit, format, and position
headers and footers, and view them as they will print. | ‘

Sheer tab specifies which areas of the sheet you want to print, and controls
the print titles, page order, and draft quatity. Alse controls whether
gridlines, cell notes, and row and column heading print. The Sheet tab is
displayed if the active sheet is a worksheet or maco sheet,

3. On the Print What, their are three option available. ‘

Seleciion option prints only the selected cells in the selected sheets.
Nonadjacent selections are pnnted on separate pages. Selecting this
overrides any print areds you have defined for the selected sheets using
Print Area option on the Sheet tab of the Page Setup dialog box.

Selected Sheets option prints the area of each of the currently selected sheets,
with each print area starting on a different page. If no print area is defined
on a separate sheet, the enti'ré.shc‘et is printed, _ :

Entire Workbaok aption pﬁn’ts the entire print area of all sheets in the active
werkbook. if a sheet does not have a print area, that entire sheet is printed, §

4. On the Copies box, specifies the number of copies to print. “
5. On the Page Range, their are two oplion available.

All option print all the pages in the selected sheets.

Page(s) optien print the range of pages Speci‘ﬁed‘ in the From and To boxes.
Page numbers you selected in the From and To boxes affect which cells
‘will be printed, not the numbering of the pages upon which they are
printed. To change the numbering of printed pages, specify a number in
the First Page Number box of the Page tab in the Page Setup dizlog box.

6. The user have option to see the appearance of the print by clicking the
Print Preview button.

7. Printer Setup option give the user an option to select among the available
printer drivers. :

8. Click the OK button to proceed printing.

5.3, MS-WORD

MS-Word is word pracessing type of software. This is analogous of converting your
computer into typewriter machine. You have page in which you type characters, you have a
ruler that show where YOUu ire as you type across the page. You have tabs steps and margin
settings, The insertion point moving across the page even ucts like the print head moving ]
across the page. -



MS-Word offer more advance features that you need to cteatz from simple to complex type
of document. When you start Word you will notice alimost the identical appearance with that
of MS3-Excel. Most of the command are represented in terms of icon, in the middle of the

workspace were you enter your text and other object included in your documents. '

Starting Word

From the MS-Window environment, you can double-click the MS-Word icon in the MS-
Office program group. In some case the MS-Office administrator is automatically loaded at
start-up of Windows environment. The MS-Office administrator menu icons ace tocated in

the upper right side of the screen. You can start MS-Word by clicking the icon.
Quiting Word

{. Move mouse pointer to File menu and click. File sub-menu will appear.

2. From the File sub-menu, move mouse pointer to Exit option and click.

The MS-Word environment will normally terminate. In some cases, if some active

documents has not yet been save. MS-Word give the user's optien to save the
documents.

Standard Toolbar

The standard toolbar which narmally shown at the top of screen helps you select the option,
frem this toolbar. The user’s can open new document, open existing document, print and save
document, and ask help to farther understand some function or procedure to accomplish
desired task. Using the toolbar speed-up the desire task instead of using the menu {located at

the top of the screen). The foltowing shows the list of standard toolbar icons and their
function.

stendard Toobar lcons

lcon Naome : Descriplion

New Greates a new fle based on the Normal template

Qpen ' Displays't.h: Open dialog box so that you can select an
existing file to open

W

{

— Save Saves the currentdogument

@ Print Prints the curreat document

@ - Print Previcw Activaies Word's pring preview features
5

A Spelling Initaces o speiling clieck




Standard Toobhar lcons

leon MNome Description

—_ - e e e ten g

Cut Cuts selected matedial to the Windows Clipboard
Ce]
— Copy Copies sclected material to the Clipboard
' @ Paste Pastcs material from che Clipboard into your docu-
ment
‘KZ‘;{ FormatPainwr  Copies the formauting of a selection to the text you
. specify
¥ Undo Undocs the commands you select from the list
L] —
—a presented
S 1¥] Redo Redoes the commands you select from the tist pre-
- sented
AutoFormat Format your document avtomatically

Insere AutoText  [nserts an AutoText enury

" " [ B
B 1A fe | {0

Insere Table Inseris a able ino your document

=a Insert Excel Inserts an Excel worksheetinio
e Worksheet your document

—

Columns Fermacs your document using columns !

) Drawing. QOpens the drawing application and ¢nables vou to
- draw a picture in vour document

EXH

- Insere Chan Inserts a chartinto vour document

¥ Zoom Control  Scales your view of the decument by the percentage
— you select

E" Help " Actvates contestsensitve help

MS-Word Basic Operation

Opening ang Existing Document

1. Click the Open Folder icon {normally second from the left) to bring up the open
dialog box, '

- [nthe Open Dialog box, select the file you to open fram File Name combimation
box.

. Click the OK button.

138

T

Changing the Formal of the Text

1. Click the arrow bulton to the right of the funr box to bring the list of avilable font. !

- Scroll through the st box by clicking on the scroll bar, and select &t Fou
on it.

s

Wby clicking

[ 2]

- Begin typing. The text will appear in the font you just selected.
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Changing the Font Size

1. Click the arrow button to the right of the fonf size box to bring the list of avaitable
size.

2. Scroll through the list box by clicking on the scroll bar, and select a size by clicking
on it,

3. Begin type. The text will appear in the font size you size selected.

Choose a Style

Perform any of the following procedures to change a font style:
* Click on the button labeled B to set the bold feature on.
You also can press Ctrl+B from the keyboard.
» Click on the button labeled I to set the iralic feature on.
You also can press Cerl+1 from the keyboard.
+ Click on the butten labeled U to set the underlined feature on.
You also can press Ctrl+U from the keyboard.
¢+ Click on the button labeled B and I 10 set both bold and italic features
You also can press Ctrl+B followed by Crrl+I from the keyboard.

Setting Special Effects

You can use a variety of special text effects:
¢ Strikethrough
¢ Superscript
+ Subscript
+ Hidden
¢« Smallcaps
+ ANcaps

To set any of these features, use the following procedure:

1. Open the Format menu and selzct the Font item.

2. If the Fonts tab is not on top, click on it.

3. In the Effect group box, select the check box that represent the special effect
you want 1o tum on.

4. Click the OK button.

5. Begin typing. Your text appears with the special effect you selected.

Setting the Indentation

1. Open the Format menu and select the Paragraph item.

2. If the {ndents and spacing tab is not on top. click on it.

3. In the indentation group box, use the Left and Right spin boxes to set the indentation
from the left and right margins. Click on the ammow buttons until the measurement is
correct, or select the text in the body by highlighting it with the mouse and then type
exact measurement you want.

4. To set first line or hanging indentation, open the Special drop-down list box by
clicking on its arrow, and select the appropriate item. Use the By spin box to set the
measurement for the first line indentation or the hunging indentation.

5. Click the OK button. Your curent paragraph takes on the indentation you just set.
Each subsequent paragraph you create takes on this pattern, unless you reset the
indentation using the dialog box.
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Sctting Line Spacing

L. Open the Format menu and select the Paragraph item.
2. If the Indents and Spacing tab is not on top, click on il.

3. In the Spacing group box, use the Before and Aftgr spin boxes 10'set the distance in
points from the previous paragraph and from the following paragraph. Click on the
arrow buttons until the measucement is corvect, or select the text in the box by
highlighting it with the mouse and then type the exact measurement you want,

4. To set line spacing within the paragraph, apen the Line Spacing drop-down list box by
clicking on its arrow, and select the appropriate item. Then use the At spin box to set
the measurement for number of lines or distance between lines, whichever is active.

5. Click the OK bution. Your current paragraph takes an the line spacing you just set.

Each subsequent paragraph you create takes on this pattern, unless you reset the line
spacing using the dialog box.

Copying and Inserting Text

1. Highlight the text by dragging the mouse pointer over the text to be selected.
2. Move pointer to Copy icon ang click on it.

3. Move mouse pointer 1o the place were you would like the insertion take place. :
4. Move mouse pointer 1o Paste icon and click on it. Altematively, you can press the right
button of the mouse to bring the menu option., select the paste by click on it.

Undoing and Redoing

f you do make a mistake, you can undo it by selecting the Undo option from the _Edit menu. .
This procedure undoes the last change you made to the document. Word always will add the g
name of the operation you are about to undo as the second word of the Undo menu item. If

you cannot undo anyihing, this option change to Can’t Undo and is dimmed.
Overstriking Text

There are times, however, when you want to type over existing text. To switch to this editing
mode, press the Insert key in the keyboard. When you 'type. the characters you type replace

any characters to the left of the insertion point. To turn off the overstrike mode, press the

[nsert key again.

Deleting Text

Use mouse pointer 10 highlight the desire text and press the Del key from the keyboard.

Insert File

I. Move mouse pointer in the location were you would like the insertion take pluce.
2. From the Insert meny, select File option. I

1. From the File name combination box, select the file you weuld like to insest.
Click the OK bution.



o

Creating the Header or Footer

1. From the View menu, choose Header and Footer.
2. The Header and Footer toolbar appear, click the switch between Header
and Footer button. The header and footer areas are enclosed by a nonprinting
dashed line.
3. Do one or more of the following;
Text - You can type the text within the dashed line that surround the header
or footer area,
Page Number - Click the icon.
Current Date - Click the icon.
Curment Time - Click the icon,
4, To return to the document, choose the Close button on the Header and Footer
_toolbar, or double-click the main text area

Previewing the Document

. From the File menu, choose Print Preview,

While in the print preview mode, you can perform the following options.

a} You can print the document by click the Print butten,

b) You can switch the magnifier on and off by clicking on the magnifier butten.

¢) You can switch to a one page view by clicking the One Fage button.

d) You can swltch to view multiple pages by clicking on the Multiple
Pages Button and dragging across the grid that appears, releasing the
mouse button when you have the multiple-page view you wantto use.

e) You can zoom in or out on your docurment by adjusting the zoom
percentage in the Zoom Control drop-down list box,

f) You can switch the view of the ruler on and off by clicking on the
View Ruler button.

2) You can squeeze a small amount of text on the finat page into the
the outer pages by clicking on the Shrink to Fit button.

h) You can expand the preview screen to show only the page, the
toolbar, and the status bar clicking on the Full Screen buttan.

I} You can exit the preview mode by clicking on the Close button.

Printing yout Document

1. From the File menu, choose Print option.
A Print dialog box appear.
2. In the Print What drop-down list box. “This option enables you to pnnt the
docurnem or several items anciltary to the document, such as Summary Info,
Annouation, Style, Autotext Entries, and Key Assignments,
3. Use the Copies box to enter the number of copies to print.
4. Use the Page Runge option to determine how much of the document to print.
You can print All the document, the Current Page, or selected Puges.
5. Check the Collute Copies check box to finish the first set of copy before
printing the second copy.
“6. When all it set correctly, close all the diulog boxes you have open,
and click OK button, the printing process begin.
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6.1.

PWA4SE DATA FILES

Data files are collection of infonnation revelant to the preparation of PW4SP. Data files are
logically group into three major areas of information. The first group of information are the
base data thal are composed of information derived from survey, ocular inspection, and
existing information from the provincial and national agencies. The second group of
information are the key parameter data that are éomposed of information derived from
applicable policies, assumption, water test result, and current cost of commodity. The third
group of information are the presentation of data which derived from the previously
mentioned groups of information’s, this data are processed and then logically arranged to
show provincial profile, existing facilities and service coverage, past financial performance,

future requirement of the relevant sector, cost estimates for future sector development, and

financial arrangement,

Base Information

I. Socie-economic Data (socio.xls)

a) Administrative Composition ( (M) Administrative Composition)
b} Past Population { (M) Past Population Page 1 t0 2)

¢) Projected Population { (M) Projected Population)

d) Household { (M) Household)

e) Services { (M) Services)

i} Occupation ( {M) Occupation)

g) Family Income, Education and Literacy ( (M) Family Income and Education)

g

. Land Use Data (landuse.xls)

a) Existing Land Use ({(M) Existing Lard Use)
b) Future Land Use {{M) Future Land Use)

3. Health Data (health.xls)

a) Morbidity, Maortality and Infant Mortality ({M) Morbidil_y and Mortality)
b) Facility and Practitioner ((M) FacilityPractitioner)

4, Water Resource Data (h2ores.xls)

a) Generat Information ( (M} General Information)
b) Water Source Information { (M) Source Information)

5. Water Supply Systemns Data (hZosupp.xls)
a) Level 11t Systéms ((S)Level HIPI-2 . P2-D)
b) Level I Systems ( (S) Level H P-4 .. P4-4)

2-56




6.2,

6.3.

6. Environmental Sanjtotion Data (sanit.xls)

a) Houschotd Toitets ( (M) Household Tailets)

b) School and Public Toilets { (M) Sch. and Pub. Toilets)
c) Drainage Facility ( (M) Drainage Facility)

d) Solid Wasta Collection and Disposal ( (M) Solid Waste)

7. Investment Data (invest.xls)

a) Previous Annual Investment { {P) Fin. Past Ann. Invest))
b) Planned Annual Invesiment { (P) Fin. Future Ann. Invest.)

Key Parameter

1. Key Parameters (keypar.xls)

a) Key Parameter (Key Parameter)
b) Level I - Safe and Unsafe (Level | Safe and Unsafe}

c) Well Source Composition (Well Source Composilion)
@) Unit Cost (Unit Cost)

€) Scoring Factor (Scoring Factor)
£} Anaua! Investment {Annual Investment)

Data Presentiation

1. Provincial Prof {e (chap 3 xls)

a) Outline of City and Mumcapalltzes (MTable 3. I 1y
b) Current Land Use (MTable 3.2.1)
¢) Drainage Areas and Flow Rates of Major Rivers (MTable 3.2.2)
d) Distribution of Households by Income Class (MFigure 3.3.1)
€) Populanon Distribution by Qccupation (qure 3.3
f) Population Dssmbuuon by Highest Attainment of Education (MFigure 3.3.3)
g) Provincial Outime on Poblic Services (MTa‘uIe 33y
h) Public Facilities and Services by Municipality (MTabte 3.3.2)
i) Previous Poputation Devclopment of the Province (MFigure 3 4.1)
j) Previcus Population Development by Muaicipality (MTable 3.4.1)
k) Present Population Distribution (MFigure 3.4.2)
1) Gutline of Urban and Rural Areas in the Province (MTable 3.4.2)
m) Household Numbers and Household Sizes (MTabI-: 343
n) Number and Rates of Ten Leadmg Causes of Morbidity,
Martality and Infant Mortality (MTable 3.5.1)
0) Reported Cases and Deaths of Notifiable Water Related Diseases (MTable 3.5.2)
p) Municipal Solid Waste Collection and Disposal, and
Service Coverage in 1994 (MTable 3.6.1)
q) Number and Ratio of Popufation to Health Facilities
and/or Medical Practitionerss (STable 3.5.1)
1} Types of Dainage Facilities (STable 3.6.1)
s) DENR Water Quality Criteriv/Water Usage and Cla:,alftcauon
for Fresh Water (8Table 3.6.2)

2. Existing Facilities and Service Coverage {chap-4.xls)

a} Information on Existing Level I Systems (MTable 4.1.2)
b} Information on Water District {(MTable 4.1.3)
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<} Information on Existing Level I Systems (MTable 4.1.4)
d) Information on Existing Level I Facilities (MTable 4.1.5)
e) Water Supply Service Coverage by Municipatity in 1994 (MTablc 4.1.7)
[} Water Supply Service Caverage by Municipality {MFigure 4.1.1)
g) Sanitation Facilities and Service of Household Toilets, Urban and
Rural, 1994 (MTable 4.2.1)
h) Provincial Service Coverage of Household Toilet Faculmes 1994 (MFigure 4.2.1)
1) School Toilet Facilities and Service Coverage in 1994 (MTable 4.2. 2)
1} Public Toilet Facilities and Service Coverage in 1994 (MTable 4.2.3)
k) Details on Existing Level Il Systems (STable 4.1,1 Sheet 1 to 4)
1} Details on Existing Level I System ($Table 4.1.2 Sheet 1 to 6)
m) Number of Level I Facilities by Safe and Unsafe Classification (STable 4.1.4)
n) Estimation of Unserved Population by Municipality (STable 4.1.5)
o) Estimation of Population Covered by Safe and Unsafe Source
by Municipality (STable 4.1.6 Sheet 1 10 2)
p) Sanitation Facilities and Service Coverage of Househotd Toilets
by Type, by Municipality, Urban and Rural, 1994 (STable 4.2.1)

3) Past Financial Performance in Water Supply and Sanitation (chap-6.xls)

a) Previous Sector Investment to the Province by Concerned Agency (MTable 6.2.1)
b) Past Internal Allotment to the Province from Cenitral Government (MTable 6.2.2)
c) Affordability in Water and Sanitation Services (MTable 6.4.1)
d) Financial Indicators of Water Districts (MTable 6.5.1}
e} Loan Status of Water Districts (MTable 6.5.2)
f) Past Internal Revenue Allotment to Municipalities from
Central Government(STable 6.2.1) 3

4) Warer Sourc‘e Development (chap—?IXIs)

a) Existing Groundwater Sources in the Province (MTable 7.1. 1}
b} Work Flow of Groundwater Avallabnhzy Map (SFigure 7.3.1)
c) Existing Spring Sources by Municipality (STable 7.4.1)

d) River Informaticn and Related Data {STable 7.5.1)

€) Water Quality Analysis Results {STable 7.5.2)

f) Existing Well Sources {STable 7.6.1)

2) Standard Specification of Wells by Municipality (STabIe 1.6.2)

3) Furure Requirement in Water Supply and Sammuon Envirgnmeént (chap-8.xls)

1) Provincial Sector Tarcrels {MTable 8.2 1)
2) Base Year Service Coverage of Water Supply (MTable 8.2.2)
3) Base Year Service Coverage of Household Toilets (MTable 8.2.3)
4) Base Year Service Coverage of Public School Toilets and
Pubtic Toilets (MTable 8.2.4) . '
5) Base Year Service Coverage of Mummpal Solid Waste System in 1994 (MTable 8.2 5)
6) Future Population by Urban and Rural Area by Municipality {MTable 8.3.1)
7) Projected Public School Enroliment und Number of Public Uu!:ly
by Mumc:palny {MTable 8.3.2)
8) Population to be Served by Target Year {Water Supply) (MTable 8.5.1) :
9) Additional Number of Houscholds to be Served by Target Year ‘ 1
{Household Toilets) (MTable 8.5.2) -
10) Additional Number of Public School Student to be Served by
Target Year (School Toilets) {MTable 8.5.3)
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11) Additional Number of Public Utilities with Sanitary Toilets
by Target Year (MTable 8.5.4)
12} Population to be Served by Urban Sewerage in Phase 1l (MTable 8.5.5)
13) Additional Number of Urban Households to be Served by
Municipal Solid Wastc System in Phase T (MTable 8.5.6)
[4) Water Supply Facilities Required by Target Year (MTable 8.6.1)
13) Sanitation Facilitics Required by Target Year (MTable 8.6.2)
16) Number of Gasbage Collection Trucks Required in Phase I (MTable 8.6.3)
17) Estimation of Base Year Service Coverage of Water Supply (STable 8.2.1)
18) Population Coverage in Phase [ Provided by Served Population
in the Base Year (STable 8.2.2)
t9) Number of Households Served by Sanitary Toilets in the
Base Year (1994)(STab!e 3.23)
20} Number of Public Schoot Student Served by School Toilets in the
Base Year (STable 3.24)
21) Number of Public Utilities with Sanitary Toilets in the
Base Year {1994) (STable 8.2.5)
22) Households Coverage in Phase I Provided by Existing Facilities in the
Base Year (Household Toilets) (STable 8.2.6)
23) Public School and Public Coverage in Phase I Provided by
Existing Facilities in the Base Year (STable 8.2.7)
24) Projected Number of Households by Urban and Rural Arcas by
Municipality by Target Year (STable 83,5) ‘
25) Projected School Enroltment by Mumcupahty by Target Year (STable 8.3.6)
26) Projecied Number of Pubhc Utilities by Mumc:pahly by Targel Year (STuble 8.3.7)
2N Populanon to be Served by Level II System in Phase [ {STable 8.5.1)
28) Population to be Served i in Phase I (Water Supply) (STable 8.5.2)
29) Population to be Served in Phase IF {Water Supply) (STable 8.5.3)
30) Additional Number of Households 1o be Served in
Phase ! (Houaeho!d Toilets) (STable 8.5. 4y
31) Additional Number of Households to be Served in
. Phase 1 {Household Toilets) (STable 8.5.5)
32) Additional Number of Public School Students to be Served in
Phase I and 1 (Schoal Toilets) (STable 8.5.6)
33) Additional Number of Public Utilittes with Sanitary Toilets in -
Phase [ and I1 (STable 8.5.7).. ..
34) Urban Water Supply Facilities Requ;red by Target Year (ST.xble 3.6.1)
35) Plan {or Expansion of Existing Leve! [l System {STable 8.6.2)
36} Rural Water Supply Facilities Required by Target Year (STable 8.6.3)
37) Urban Household Toilets Required by Target Year (STable 8.6.4)
38) Rural Househiold Toilet Required by Target Year {STable 8.6.5)
39) Public School Toilets Required by Target Year {STable 8.6.6)
40) Public Toilets Required by Target Year (STable 8.6.7)

6) Cost Estimates for Future Secior Development (chap- 10.x1s)

a) Unit Cost of Facilities by Type and Service Leve! (MTable 10.2.1)

b) Construction Cost of Required Facilities by Municipality (MTable 10.3.1)
¢} Recurrent Cost {MTuble 10.4.1)

d) Unit Cost of Level 1 (Deep Well - 40 meter Depth) (STable 10. 2.1)

¢) Unit Cost of Level [ (Deep Well - 80 meter Depth (STable 10.2.2)

£) Unit Cost of Level [ (Deep Well - 120 meter Depth) (STable 10.2.3)

g) Unit Cost of Level [ (Deep Well Rehabilitation) (STabie 10.2.4)

h} Unit Cost of Level 1 (Shallow Well - 18 meter Depth) (STable 10.2.5)
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1} Unit Cost of Level 11 (600 Service Population) {STable 10.2.6)
j) Unit Cost of Level 1 {5, 000 Service Population) {(STable 10.2,7)
k) Unit Cost of Level 1T (10, 000 Service Population} {STable 10.2.8)
1) Unit Cost of Level ) (15,000 Service Populatlon) (STable 10.2.9)
m) Unit Cost of Flush Water Sealed with Septic Tank Toilet (STable 10.2.10)
n) Unit Cost of Pour Flush with Double Pit Latrine (STable 10.2.11)
0) Unit Cost of Ventilated Improved Pit Latrine (STable 10..2.12)
p) Unit Cost of School Toilet {(STable 10.2,13)
q) Unit Cost of Public Toilet (STable 10.2.14)
1) Consteuction Cost of Water Supply Facilities Required for
Phase I (2000) (STable 10.3.1)
s) Construction Cost of Water Supply Facilities chulred for
Phase ! (2010) (STable 10.3.2)
1) Cost of Sanitation Facilities Required for Phase [ (2000) (STable 10.3. 3y
u) Cost of Sanitation Facilities Required for Phase 1I (2010) (STable 10.3.4)

7 FinancialArrangemems {chap 11.xis)

a) Projected Internal Revenue Al!ctment for Medivm-Term
Sector Development (MTable 1} 2.1
b) Projected Allotment of IRA to the Relevant Sectar by
Component, 1596-2000 (MTable 11.2.2) :
<) Financing Requirernents by Sector Componcnt for the Province {MTable 11.3.1)
d} Additional Fund Requirement for Mediuvm-Term Plan (MTabte 11.3.2}
e) Intemal Revenue Allotment for Water Supply and Sanitation Sector
by Municipality (Mgdlum-Term De_velopment §996-2000) (MTable 11.3.3) §
f) Retationship between Funding Levels and Percent of Coverage s
for Water Supply Sector (MFigure 11.4.1)
8) Relationship between Funding Levels and Percent of Coverage
for Sanitation Sector (MFigure 11.4.2)
h) Municipal Investment Need Ranking for Urban Water Supply (MTab!e 11.4.1)
i) Distribution of Provincial IRA to Mumcnpaluy for
Urban Water Supply (MTable 11.4.2)
3} Municipat Investment Need Ranking (MTable 11.4.3)
K) Percentages for Annual Investment {STable 11.3.1)

1) Comprehensive Investment Need Ranking of the Municipalities (STable 11.4.1)

DATA FILES LINKAGES

Linkages are logical connection between records in the data files. Through linkages, once the
user's updates the source data, all data in the streams of linkages are dynamically updaled.
Linkages are the convenient tools of:upduting related data, these also shield the user’s from
the complexity of formula manipulation. With the aid of the data finkages the user's can

concentrate more in validating the source data. 1
E

The following table lists the logical connections for each worksheet.
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Table 2.6.2  Data File Linkages
Destination Link Souree Link H
1
Chapter No. Table No, Title Filename Ts;blchnrm Title i
umber i
Chapter- 3 MT 3L Ouiline of Cily and Municipality Socio,xis M 132 Past Population Page 2 ji
MT3.2.0  [Current LandUse : Landuse.xls . [M2.1 Existing Landuse !
MF 3.3.1 Distibution of Housecholds by Income Class Chap-3.xls’ 5T 3.3.1 Distiribution of Household by Income Class !
MF3.3.2 Pcpulalion Disuibulion by Occupnlion Chap-3.xls 8T 332 Gainful Warkers by Occupat:on Group and Major {
L ' Industry Group - : |
MF3.3.3 Population Disiribution by ngh(:sl An.unlmcnl of Chap-3.xls- 5T333 Houschald Populatien by Highest Education Attainment
" |Bducation S ' RO !
MT 3.4.1 & [Previous .Populnuon Devnlopmcm by Mummpnhty Socio.xls MT 1.21 Past Population Page 1 |
MF 3.4, S N |
- - - M122 Past Popuiation Page 2 ;
MF 3.4.2 Present Population Distribution ™ < Socio.xls M 1.2.2 Past Population-Page 2~
MT 3.42 Outline of Urban and Rural Areas in the Province Chap-3.xls MT3.1.1  [Oulline of City and- Mumcxpamy
™ e e §T332 Educauon Level and  Literacy of Popunnon
- Socio.xls M1.22 Past Populahon Page 2
= MT 3.4.3 Households Numbers and Hauschold Sizes Socio.xls - Ml14 Household Number -
Chap-3.xls MT 342 Qutlinc of Urban and Rum! Areas in the Province |
MT 3351 Mumber and Rates of Ten Leading Causes of Mobadny. Hcalth als M 3.} Morbzd;ty and Moﬂnlﬁy Summary i
Monality, & Infant-Moriality : l
MT 3.5.2 Reporied Cases and Dcnlhs of Notifisble Water reluted Hcallh xls M3 Morbtduy and Morcaluy Summary )
Disepses - t
MT 3.6.1 Municipal Solid Waste'- Collct.lmn :mrJ Drsposa! Somo.xls M4 Houschold Numb:r \-}
and Service Coverage, 1994 Sanit.xls M6.5 SolidWaste' Co}l:cuon and Disposa! 1{
: - Chap-3.xls MT 3.3.2 Public Facilities and Services by Municipality !:
S$T 3.3.1 Number of Family by Income Class by Municipality Socio.xls M7 Family-income-and Education !{
§T3.3.2 Papulation Distribatian by Occupation Socic.xls M6 OQccupation - i
ST 3.3.3 - |Education Leve] andLiteracy of Population Socio.xls MI17 - |Family Income-and Education - \'[
Chapier - 4 IMT 4,12 |Information on Existing Level [ Systems Chap-4.xls ST 4.1 Information on Exisling Level {{! Sysiems T
S : : Sheet 1,3, f
| and 4 {!
Note:  MT - Main Repon Table, MF - Main Repont Figure, - $T- Supporting Report Table, ORI 1) HeXT [T ...

M - Questionnaire Form (Musicipal D,

S - Questionnatre Farm (Systemy Data),

F - Questionnaire Form (Facilily Data),
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Table 2.6.2

Data ¥ile Linkages

Destination Link

Source Link

Chapter No. Table No. Title Filename Table/Form Title l
Number it
Chapter - 4 MT 4.1.3 Informatnion on Waier Disiriet Dala Chap-4.xls ST4.l.l [ntromalion on Existing Level 1] System |
: , Shect 1 &4 !
MT 4.1.4 Informarion on Existing Level I System Chap-4._xls 5T 41,2  |Existing Level 1] Systemn
: ' - 7‘ "~ Sheet1 &2 .
MT 415 |Estimalion of Unserved Populalion by Munitipality Chap-d.xis 5T 4.5.4 -  |Numberof Level ] Faolities by Safe and Unsafe
. Classification
STA4.1.6 Estimation of Population Covered by Safe and Unsale
Sheet | & 2 |Source by Mumicigality ©
MT 4.1 Water Supply Service Coverage by Municipality Chap-d.xls §T4.1.6 Bstimation of Population Covered by Sufe and Unsale
. Sheet2  Source by Municipality
: Socioxls M 1.3 Projected Population
MT 4.2.1  jSapitation Faulmcs and Service Coverage of Hﬂuschoid Socio.xls Mid Houschold Number ™
Toilets, Urban and Rural, 1994 o . R -
Chap-4.xls 5T 4.2.1 Sanitation Facilitics and Service Coverage of Houschold
’ Toilets, by Type, by Municipulity, Urban and Rural, {994
MT 4.2.2 School Tertets Facilities and Service Coverage, 1994 Sanit xls M6.2 School Toilets
Sheet ) - -
MT 422 Public Toilets Facilities and Service Coverage, 1994 1Sann .xis Med Public Toilets. .
Sheet 2 ) ' o '
ME L1 Water Supply Caverage of the Provinee Chap4.als -~ |[MT4.1.7 Water Supply Service Coverage by Municipality
STd14 Number of Level § hulltlca by S.ufu .md Unsm. : H20Supp.xls - |(F) 53,0, [Levell Facility
Classification - Keyparxls  |ST 2565 Level | Safe and Unsafe Percentape
§T41.5 Esmnauon_ol’ Unserved Popalation by Municipality . Socioxls - M 122 Past Population Page 2
: : Chap-4.xls ST4.1.6 IEstimation of Population covered by Safe and Unsafe
Sheet 1 &2
§T40.2 Details on Exmmg Level 1l System
. Sheet 2 :
§T 4.2 Sanitation Facilities and Service of Household Toikews by {Socio.xls Ml Haus::ho!d Number
Type. by Municipality, Url:un angd Rural :
1954 Sanit.xls M 6] Household Toilr.is .

Nowe:

MT - Main Repun Table,
‘M« Questionnare Form dMunicipad Baa),

MF - Main Repont Figure, ST - Supporung Repont Tuble,

§ « Questionisire Form (System Dt -

canlinue 10 sexl page ...

- Questionnaire Form (Faginy Data).
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Table 2.6.2  Data File Linkages
‘r
Destination Link Source Link |
Chapter No. | Table No, Tite Filename | T oreor Title
; Nomber ;
Chapter - 4 ST 4.1.6 Estimalion of Popuiation Covered by Sale and Unsafe  |Chap-4.xls ST4.1.4 Nomber of Level | Facilities by Sale and Unsafe i
Sheet | Source by Municipality . [Classificaion . |
' $T4.1.5 Estimation of Unserved Pepulation by Municipalily :
ST4).6 Estimation of Population Covered by Safe and Unsafe  [Chap-4.xls ST4.1.5 Estimation of Unserved Population by Municipalily f
Sheet 2 Source by Municipality . L ) ([
: 5T4.1.6 Estimaiion of Population Covered by Safe and Unsale |l
Sheet Source by Municipality
Chapier - 8 MT 8.2, Provincial Sector Targets Keypar.xls $T2.62  {Key ParameterTable )
Chap-B.xls MT 8.5.1 Populaiian to be served by target year(Water Supply) 1
MT38.52  |Additional Number of Households to be Served by t
Target Year(Household Toilets) g
MT 8.5.5 Populztion to be Served in Urban Sewerage in Phase IF |
MT 8.56  |Add) No.of Urban Households 10 be scrved by
Municipal Solid Waste System in Phase ] :
ST 8.57 Number of Public Uiilities with Sanitary Toilets in g
tPhases Yand 11 _ |
- ST 8.6.6 Public Schaol Toilets Required by Targel Yeor i
MT 5.2.2 Base Year Coverage in Water Supply Chap-4.xls MT a7 Water Supply Service Coverage by Municipality j
Chap-8.xls ST 8.2t Estimation of Base Year Service Coverage of Water
Supply - . |
MT 8.3.1 Fulure Population by Urban and Rural Area by A
Muanicipality [!
MTB.2.3 Base Year Serviee Covernge of Houschold Tuoilets Chap-8.x1s ST 8.23 Number of Households Served by Sanitary Toilets in the §
' Base Year(1994) i
MT 8.3.1 Future Population by Urban and Rural Area by i
Municipality - :
MT 8.2.4  |Basc Year Service Coverage of Public School Tailets and|Chap-4.xls MT 4.2.2 Scoal Toilet Facililies and Service Coverage in 1994 |
Publie Toilels Sheet § ;

Nole: MT - Main Repun Table, - MF.-MainRepon Figure, ST - Supporting Repon Tahle,
M - Questionaaire Form (Municipal Dala),

S - Quesnonnaire Form (System Dala),

Conlinue 19 next puge ...

F - Guestionnaire Form (Facility Data).
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M - Questinnnzire Form (Municipal Data),

S - Questionnaire Form (System Data),

Table 2.6.2  Data File Linkages
Destination Link Source Link F
|
Chapter No. Table No. Title Filename Tx;::c“?‘b::m Thle
Chapter - 8 MTE.2.4 Base Year Service Coverage of Public Sehoo! Toilets and jChap-8.xls STR.24 Number of Public Scheol Students Served by School
Publi¢ Toileis S _|Toilets in the Base Year (1994)
) §T8.2.7 Public School Students and Public Utitities Covcragc in
Phase 1 Provided by Existing Facilities in the Base Year
MT 8.2.5 Base Year Service Coverage of Munigipal Solid Wasie  jChap-3.xls MT 3.6.1 Municipal Selid Waste -Collection and Disposal, and
System in 1994 Service Coverage, 19947
Chap-8.xis ST8.35 Projected No. of Households by Urban and Rural Area by |
) Municipality by Target Year I
MT 8.3} [Fulure Population by Urban and Rural Arca by Socio.xls M 1.2.2 Past Population Page 2 li
Municipality . i
M 1.3 Pro;cclcd Popu!auon
MT 8.3.2 |Projected Public School Enrollment and Number of Chap-8.xls 5T 8.3.6 Projecied School Enrollment by Mumc:pa'l ity by Targe!
Publie Utility Facililies by Municipality Year
§T8.3.7 Projected No. of Pubhc Uulmcs by Mumcspalny by
Targe: Year -
MT 8.5.1 Population 1o be Served by Target Yeur{Waier Supply}  |Chap-8.xls 5T 8.2.2- Populalion Coverage in Phase [ Provided by Served
Popuistion in the Base Year{Water Suppily)
§T85.2 Populaionto be Served in Phase F(Water Supply) -
ST48.5.3 Population to be Served in Phase II {Water Supply)
MT B.5.2 Additional Number of Houscholds 10 be Served by Target {Chap-8.xls STR.S54 Additional: Number of Households 1o be Served in Phase
Year(Houschold Toilels) I(Housckold Toilets)
5T&8.55 Additional Number of Households 1o be Served in Phase
i! (Houschold Toilets):- .
MTB.5.3  {Additional Number of Public School Students 1o be Chap-8.x1s ST 836 Projected School Enrollmm'by'Municipalily by Targc:
Served by 1arget Year{School Toilels) Year - . 8
5T 8.5.6 Additional Number of Public School Studeats to be
Served in Phases ! and 11{Schoo] Toilets)
MT 8,54 Additional Number of Public Unlities with Sanitary Chap-8.xls ST 8.5.7 Number ol Pubhc Unhtacs with Sanitary Toilets in Phases
Toilels by Target Year ] land 1 ) !
MT8.5.5 Popuiation 10 be Served by Urban Sewerage in Phase It [Chap-8.x1s MT38.2.1 Pravineial Secior Targets -
MT 83.1  [Future Population by Urban and Ruraf Area by
Municipality
Noer MT - Main Report Table,  MF - Main Repont Figure, ST « Supporting Repornt Table, conlinue 1o next page ...

F - Questionnaire Form (Facidity Data),
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Table2.6.2  Data File Linkages
Destination Link Source Link
Chapter No. | Table Na. Tie Nlename | Toerror Title
umber
Chapter - B MT R.5.5 Population 16 be Served by Urban Scwerage i Phase 11 [Chap-8.xls MT 8.5.! Populution 1o be Served by Targel Year{(Wider Suppiy)
MT 8.5.6 Add'} Ne. of Urban Houscholds Lo be Served by Chap-8.xls MT 8.2} Provincial Sector Targels
Municipal Solid Waste Sysiem in Phase'] ' o o
' MT 825 Base Year Service Covernge of Municipal Selid Waste
Sysiem in 1994 -
Chap-8.xls ST 83> Projecied No. of Households by Usrban and Rural Area by
Municipality by Target Year -
MT 8.6,1 Waler Supply Facilitics Reqguired by Targel Year Chap-8.xis ST8.6.1 Urban Water Supply Facilities Required by Target Year
i
ST8.63 Rural Water Supply Facilities Required by Target Yeur
MT 8.6.2 Sanitation Facilities Required by Target Year Chap-8.x1s MT 831} Fuiure Papulation by Urban and Rural Area by
Municipality
MT85.2 Additional No. of Household 1o be Served by Target
Y cartHousehald Totleis) 7
ST8.S57 Number af Public Utilitics with Sanitary Toilets in Phasex
fandll -
ST 8.6.6 Public School Toilets Required by Tarpet Year
MT 8.6.3  |Number of Garbage Collection Trucks Requirad in Phase [Chap-8.xls MT 8.5.6 Add'l No, of Urban Households (o be Served by
| Municipal Solid Wastz Systeny in Phase 1 i
STH2L Estimanion of Base Yeur Service Covernpe of Waler Chap-4.xls MT 4.4.7 Water Supply Serveice Coverage by Municipatity
Supply : S
Chap-8.xls MT 831 Future Population by Urban and Rural Areaby
Muynicipality
5T8.2.2 Populution Coverage in Phase } Provided by Seeved Chap-8.xls MTB.22 Base Year Coverage in Water Supply i
Population in the Base Year (Wauer Supply) ) i
MT 8.3.1  |Fulure Population by Urban and Rura) Arca by t
: Municipality i
ST 8.2 Numper of Households Served by Sannary Toilets in the  |Chap-4.xls $T4.2. Sanitation Focilities and Service of Household Toilers by
Base Year (1994) Type. by Municipality, Urban and Rural, 1994
Clap-8.xls MT B.3.1 Fuwure Population by Urban and Rural Areuby

Municipalily

Motz MT - Maia Repon Tuble,  MF - Main Repon Figure, ST - Supponting Reporn Tuble,
M - Questionnaire Formy (Mumcipal Data),  § - Queshionnaire Fonn (System Data),

continue 1o next page ...

F - Quesvionnaire Form (Facility Dala).
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M . Questionnaire Form (Municipal Dua),

s- Qucmunumrc Form {System D.\ln)

Table 2.6.2 . Data File Linkages
Destination Link Souree Link !
Chapter No. | Table No. Titte Filename | 12oi/Form ‘Title |
Number - 1
Chapter - & 5T 8.2.3 Number of Houschoids Served by Sanitary Toilets in the |Chap-8.xis ST 8.3.5 Projccted Number of Households by Urban and Rural
Basc Year (1994) Area by Municipality by Torget Year |
ST 824 Numberof Public School-Students Served by School  |Chap-d.xis . MT4.22 School Toiltts Fasilities and Service Coveroge, 1994 !
Toilets in the Base Year(1994) Sheet! o o |
Chap-8.xis ST8.3.6 Projected School Enrollment by Municipality by Target
Year -
ST 825 Number of Public-Ulilities with Sanitary Toilets in the Chap-4.gls - |MT 422  [Public Toilets Facilities and Service Coverage, 1594
Base Year (1994) : Sheet 2 : :
§T8.2.6 Houschold Coverage in Phase 1 Provided by Existing Socio.xls M4 Household Number !
Facilitics in the Base Year (Houschold Toilets)
Chap-8.xls MT 823 Base Ycar Service Coverage of Houschold Toilets
5TE23 Number of Households Served by Sanitary Toilets in the
Base Year {1594) ;
ST8.3s Pro_;cctcd Number of Houstholds by Urban and Rural |
Area by Municipatity by Target Year i
ST827  1Public School Students and Public Utititics Coverage in [Chap-8.xls ST8.24 Number of Public School Students Served by School !
Phase | Provided by Existing Fucilities Toilets in the Base Year(1954) _ |
in the Base Yeor ST8.25 Number of Public. Utilities with Sanitary Toilets inthe |
Base Year (1994). {
ST8.36 Projecied Schoo! Encoliment by Municipality by Targct |
Year . !
$T8.3.7 Prajected No. of Pubhc Ulilities by Municipality by \
Targer Year
ST 8.3.5 Projecied Numher of Households by Urban and Secio.xls M122 Past Population Page 2 ' |
Rural Area by Municipality by Target Year M 1.3 Projected Population :
M 1.4 Household Number
ST83.6 Projecied School Enrullmcni hy Mumup.lllly by Socio.xls M122 Past Population Page 2 !
Target Year o M 13 Projected Population ' }
5T 8.3.7 Projected Number of Public Ullhlu.\ by Mumupahly by Chap_-s.xls ST8.2S5 Number of Public Utilities with Sanitary Toilets in the |
Turget Year ] : ] Base Year (1994) ' h
Nute: MT - Main Report Table,  MF - Main R:.port Figure, - ST - Supporling Report Table, continue o next page ...

F - Questionnaire Form (Facility D:\In).: .
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Table 2.6.2 Data File Linkages

Destinution Link Source Link

Chapier No. | Table No, ‘Title ' Filensme | Loi/Form Title
Number :
Chapier - 8 ST 8.5.1 Papulation 1o be Served by Level 11 Sysiem in Socioxls M LI |Adminisirative Composition
Phase | Chap-8.xlx ST8.35 . iProjected Number of Houschelds by Urban and Rural
Arca by Municipality by Turgel Year
ST83.2 Papulation 1o be served in Phase ! {Water Supply) Socio.xls M3 Projecied Population

Chap-8.xls MT 822 Basc Year Cavcmgc in Water Supply )
ST 8.5.1 Populauon to be Served by Level 1 Syszr.m in Phase !

ST8S53 Poputation to be Served in Phase I Water Supply}) Socio.xls M1} Prcuccicd Popul.suon
: ) y Chup-8.xls ST RS2 Poputation 10 be Served-in Phase 1 {Water Supply)
STHRSH Additianal Number ol Households io be Seeved in Phase  [Chap-3.als. MTB.2.1 Peovincial Secior Targets

I(Household Toilets) : S _ _
ST 8.2.3 Number of Houscholds Served by Sanitary Teilets in the

Base Year (1994)
ST835 Projecied Number.of Househoids by Usban and Rural
Area by Muonicipality by Tarpgel Year

ST R3S Additional Number of Houscholds to be Scrved in Plinse  |Chap-8.xls MT 8.2.1 Provincial Sector Targets

H{Houschold Toiles)
ST R3S Projected Number of Houscholds by Urban and Rural

Arca by Municipality by Target Year
STB.54 Additiona! Number of Households 10 beServed in Phase |
1{Houschold Toilets)

5T 856 Addiional Number of Public Schouof Students to b Chip-8.als MT 82! Provincial Sector Targers

Served in Phases 1 and H (School Toilets) .
ST 8.24 Number af Public School Studenis Served by School

Toilets in the Base Year{ 1994)

; o i

STH.36 Projecied School Enroliment by Municipality by Targer |

Year i

§T 8.5.7 Nutwbes o Public thilities with Samitary Toilews in Phases{Chap-8.xls MT 8.2.1 Proviacial Secior Targels '

Fand I
STR2S Number of Public Lhilities with Santtary Toileis in the

Base Year (1994)
ST8.37 Projecicd Mumber of Public Utilities by Musicipality by
Tarpet Youe

Note: M- Aain Repon Table,  ME - Ma Report Fiygare, 871 - Supporting Report Fabi, COUIINIE 10 HEXE PUgE ...

1+ Questioniaire For (Alwicipal Dy, 8« Questionaine Form (System Dinad, - - Questionnaire Form (Fagility Data).
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Table 2.6.2  Data File Linkages
Destination Link Scurce Link
) ; . Table/Form oo
Chapter No. Table No. Title Filename Number Title
Chaper- 38 5T 3.0.! Urban Water Supply Facilities Required by Targel Year  [Socioxls M3 - Projected Popuiation
Keyparxis . [§T2.6.2 Key Parameter Table
Chap-4.xls 5T4.1 Details on Existing Level 111 Systems
Sheet | and 3
Chap-8.x1s STEAS bejec:cd Number of Houscholds by Urban and Rural
Arca by Municipality by Target Year -
MT 8.4 GroundWaicr Productivity
STRS52 Pnpu!:mon 10 be Served in Phase | (Walcr Supply)
Chap-8.xis° $TRS5.3 Population o be Served in hase 1] (Water Supply)
ST 8.6.3 Rural Water Supply Facilities Required by Target Year  {Chap-T.xls 5T7.6.2 Standard Specification of Water in the Municipality
Chap-8xls  |[STH.3.5 Projected Number of Houscholds by Urban and Rural
Area by Municipality. by Target Year
MT 8.4.1 GroundWater Productivity
5T38.5.4 Populanon 1.3 chcrvcd by chcl ] Systcrn in Phase |
5T 8.6.4 Urban Household Toilets Required by Target Year Chap-8.x1s MT3.5.2 - |Adduional Number of Households to be Served by Target
Year{Household Toilets) -
STEB.45 Rurat Houschold Toilets Required by Targer Year Chap-8.xls MT8.5.2 Additional Number of Households lo be Scrved by Turget
- Year{Household Toilkets)
STHAG Public Schuol Tuilens Reguired by Targel Year Chap-K.xls STHE5.6 Additional Number of Public Sehool Swdent be Scrved
- Co ) E in Phase 1 and Phase It (School Toilets)-
5T 8.6.7 Public Toilets Reyuired by Target Year Chap-8.xls $T8.57 Number of Public. Uhlmcs with Sam:ary Toileis in Phases
' L A land IT
Chaper - 10 MT 10.2.1  (Unit Costof Fagilities by Type and Service Level Keypar.xls ST 2.6.6 Unit Construclion Cosl ul‘ Dmcﬂ:nl Faulmcs
MY 10.3.1  |Construction Cost ol Required Facidities hy Municipality {Chap-10.xls ST 1031 Conslruction Cosl of Water Supp!y Facilities Required fon|
T Phase ! (2000
ST 1032 Consteuction Costof Wat:r Suppty Facilities Required for
Phase 11 £2010) -
STi0.33 Cost of Sanitation Fac:htncs chulrcd for Phase 1{2000)
ST 10.3.4 Custs of Sanitation Facilities Required for Phase 1 {2010)

Mote:

MT - Main Repont Table,
M - Questionnure Form (Municipaf Data),

MF - Main Repurt Figure, ST - Supporting Report Table,
§ - Questionnaire Form (System Dadi),

(.‘tMHl’HHE e neXl page ...

F = Questionnaire Form {Facility Data),
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Table 2.6.2  Data File Linkages

Destination Link Source Link ‘
t
Chapter No. Table No, Title Filename T?:MFOW Title
Number
Chaper - 10 MT 10.4.1  |Recurrent Cost Keyparxts  [ST2.62 . [Key Parameier Tabic o ;
Chap-8.xls MT 822 ' {Basc Year Coverage in Water Supply _ .
MT8.2.4 Base Year Service Coverage of Public School Toilets and
o |padlieToiless. . .o
STE3S - |Projected Number of Househoids by Urban and Rural I
. Arca by Municipality by Target Year
MT 8.5.1 Population 10 be Scrved by Target Year{Water Supply)
ST866 |Public Sehool Toilets Reguired by Targe: Year !
, _ ST8.67  |Public Teilets Required by Target Year . ‘
Chap-11.xls ST 11.3.] Percentages for Annual Invesiments
ST 1031 Consatruction Cost of Water Supply Facilities Required for|Chap-8.xls MT8.5.1 Population 10 be Served by Targel Yean(Waer Supply)
Phase 1 (2000) T R |
' MT8.6.! Water Supply Facilities Required by Target Year i
ST 8.63 Number of Garbage Collection Trucks Required in Phase |
! : : - :
Chap-10.x13 MT 10.2.1 Unit Cost of Focilities-by Type and Scrvice Level }
ST 1032 |Construction of Waier Supply Facilitics Requived for Keypar.als §T262 Key Parameter Table ™ i
* |Phuse 11 (2010) A ' j
Chap-8.xls MT 8.5 Population 6 be Served by Target Year(Water Supply) }
ST 8.6.3 Number of Garbage Collsciion Trucks Required in Phase f{
. | . . i
Chan-10.x1s _ {MT 10.2.1  IUnis Cost of Facilitics by Type and Service Level }
§T10.3.2 Cos! of Sunitation Facilities Required Jor Phase | {2000) Chap-Y.xls MT 8.6.2 Sanjation Facilitics Required by Target Year {[
|
ST 8.67 Public Toilets Required by Tarpet Year i‘
o Chup-10.x1s IMT 1021 Unit Cast of Facilities by Type and Service Level i
ST 10.34  |Cost of Sanitatien Fucilitics Requincd for Phuse 11 (201 0) {Chap-3.2ls MT 8.3.4 Future Population by Urban and Ruzal Area by :
Municipality Jﬁ
MT 8.5.5 Poputation to be Served by Urban Sewerage in Phasc 11
MT 8.6.2 Cannation Facilitics Required by Target Yeour 2

Note:  MT - Main Report Table,  MF .« Main Repont Figure, ST - Suppaning Repon Tuble,
M - Questionnaire Form (Municipal Diva), S - Questionnaire Form (System Data), F- Questionnaire Furm (Facility Data).

CONLNIE o NeXE puge ...
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Table 2.6.2 Data File Linkages

Destipation Link Source Link

Chapter No. Table Ne. Title ‘ Filename Table/Form Title
- Number
Chapter - 10 §T10.3.4  |Costof Sanitation Facihilies Required for Phase [ Chap-8.xls ST8.6.6  |Public School Toilets Required by Target Year :
(2010) . |sT867 Public Toilets Required by Target Year - :
: : Chap-10.xls  |MT 10.2.1  {Unit Cost of Facilities by Type and Service Level '
Chapter - 11 MT [E21  [Projected Internal Revenue Allotment for Mediom- Secioxls M LI Administrative Composition
Term Sector Development Keypar.xls ST 262 Key Parameter Table
Chap-6.xis MT 622  |Past Iniernal Rcvcnuc Allotment to the Province from

- Central Govemment .-
Chap-1L.xls MT 11.2.] Projected Internal Revenue Alloiment for Medium - Term,

MT 11.2.2  |Project Alloiment of IRA 10 the Revelant Sector by

Component 1996 - 2000 Setlor Development -
MT 11.3.1  [Financing Requirements by Sector Component forthe  [Chap-10.xls ST 10.3.2 Construction of Water Supply Facilities Required for
Province Phase 1} (2010) i
: Chap-11.xls ST 11.3.] Percentoge rorAnnua! lnvestiments i
MT 11.3.2  |Aduitional Fund Requirement for the Medium-Term Plan [Chap-11.xls MT 11.3.1  (Financing Requircments by Sector Component forthe |
- ' ~ : o Province
MT 1133 |lnternal Revenue Allotmenr for Water Supply and Chap-10.xis ST 10.3.1 Canstruetion Cost of Wagcr Supply Faciiities Required |
Sanitation Sector by Municipality (Medium-Term for Phase | (2000 ;

Development /1996-2000)
' ST 1033 Cost of Sanitation Facilities Required for Phase § (2000)

Chap-11.x15 MT 1122 |Project Alloiment of IRA 1o the Revelant Sector by
Component 1996 - 2000

MT 11.3.}  |Financing Reguirements by Sector Component for the !
Province. ) !
MT 11.4.2  |Distribution of Provineial IRA (o Municipalities for |
Urban Warter Supply
MT 1141 |Municipal Investmeni need Ranking for Urbun Water Keypac.xls ST 2.6.7 Scoring Factor for Municipal Invesitnent Ranking for
Supply Urban Water Supply .
Chap-8.xls ST8.22 Number of Households Served by Sanitary Toilets in the
Base Year (1994)
MT 8.2.2 Baze Year Coverage in Water Supniy ‘
MT 1142 {Distribuion of Provincial IRA 10 Mumup.xhnu lor Chap-11.xds MT 1122 |Project Allotment of IRA 10 the Revelant Sector by ,'
| Urban Wialer Supply ' Component 1996 - 2000 ] f,

Notet M'T - Main Report Tablke,  MF - Main Report Figure, ST - Supponing Report Table, continue 1o next puge ...

M - Questionnaire Furmy (Municipad Dina), ~ § - Questionaaire Form {System Qata), 7« Questionnaire Furm (Facilily Data).
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Table 2.6.2

Data File Linkages

LPTacE Py ]
s

Destinntion Link

Source Link

Chapter No. | Tuble No. "Fifle Filename r’:"ﬁ“m Titie
umber
Chapter-11 MT 1142 [Distnbubian of Provineial IRA 10 Municipalitics for Chap-4.xis MT 1131 |Finanting Requirement by Sector Component for the
Urban Water Supply Provinge - ' . .
MT 1141 [Municipal Tavestment need Ranking for Urban Water
. fSepply ..
Chap-10.xls (ST 10.3] Construction Cost of Water Supply Facilities Required for
’ Phase 1 (2000)
ST 1033 Cost of Sanilation Facilitics Required for Phase 1 (2000)
MT 1143  jMumcipal investmeals Neod Ranking Chap-1t.xls ST 114l Compichesive Investment need Ranking of Municipalies
ST LA Perventages lor Annual Invesunents Keypar.ils ST 2.64 Anpuil Distributicn of tnvestment Cost Required by Sub-
. = . : Sector for Medium=Term Development Plas
ST 1141 Comprehesive lnvesimens need Ranking of Municipalities | Keypar.xls 18T 2.6.8 Scoring Fuctor for Mupicpal Comprehensive tnvestiment
o . Ranking - ) :
Chap-8.zls STE2.2 Populatian Coverage in Phase | Provided by Served E.
Population in the Base Year {Water Supply) 5]
MTE.23 Base Year Service Coverage of Houschald Toilets ;5
Chap-11.xk MT 1141 IMunicipal Investment nced Ranking for Urban Water }
Supply ii

Note: M7 - Adain Repont Table,
M - Questionnaire Form {#unicapal D), S - Questionsaire Form {System Data).  F - Questionaaire Form (Facility Data).

ME - Main Repurt Figure, - ST - Supporning Report Table,
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